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Glossary 229
Index235

Preface:
Before You Begin

Welcome to TOPS Terminal!  TOPS 
Terminal allows you to use your 
Macintosh to communicate with other 
computers on a local area network or 
over a modem and phone line.  This 
section tells you what hardware you 
need to use TOPS Terminal and how to 
install TOPS Terminal software on your 
Macintosh.  It also includes information 
about this manual and about on-line and 
telephone help.  

H  ardware & Software Requirements  

To use TOPS Terminal, you need:
• Macintosh computer

- 512KE, Macintosh Plus, Macintosh SE, or Macintosh II 
- System 4.1 and Finder 5.5, or higher  
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- Two two-sided (800K) floppy drives or one 800K + hard disk
   (a hard disk is recommended for best performance)  

• Network and/or phone connection for Macintosh

The network connection can be an AppleTalk-Ethernet combination or direct Ethernet.  
(AppleTalk in this context refers to a local area network cabling system which plugs directly into 
a standard Macintosh.)  If you do not have a direct Ethernet connection, your AppleTalk network 
must be connected to Ethernet through an AppleTalk/Ethernet gateway (such as the Kinetics, Inc. 
FastPath product).  

TOPS Terminal will also allow you to connect directly to a remote computer through the 
Macintosh modem port using what is known as a “null-modem” or “modem eliminator” cable 
(Apple Part Number 590-0029-00).  

C  opy Master Disk  

The TOPS Terminal software is distributed on one 800K floppy disk.  
The programs contained on the disk are not copy-protected, so you 
may run them either from a floppy disk or from a hard disk.  The first 
thing that you should do, however, even before installing TOPS 
Terminal, is to make a copy of the master distribution disk.  Then put 
the master disk in a safe place.  If the copy is lost or becomes 
damaged, you can always make another copy of the master disk.

S  oftware Installation  

The TOPS Terminal program disk contains the System Administrator 
folder and three files: the TOPS Terminal program itself, TOPS 
Terminal Help, and the TOPS TCP/IP module (TCP/IP is a recognized 
standard for network specification; see the Introduction following this 
Preface for a detailed description).  
See the “System Administration Guide” (Appendix G) if you are 
responsible for installing network software from the System 
Administrator folder.  Kipper, a program that automatically assigns 
addresses to the Macintoshes on a network, is included in the 
System Administrator folder; Appendix G includes a description of 
Kipper and instructions for installing it.  
Follow the instructions below to install TOPS Terminal, TOPS 
Terminal Help, and TOPS TCP/IP.  
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Installing TOPS Terminal & TOPS Terminal Help

• Copy TOPS Terminal and TOPS Terminal Help 
   • Hard disk system:  copy TOPS Terminal and TOPS Terminal Help into a folder on your disk. 

   • Floppy-disk system:  use your copy of TOPS Terminal and TOPS Terminal Help in the 
external drive, while keeping your system disk in the internal drive.

Installing the TOPS TCP/IP Module

Note:  If you plan to run TOPS Terminal over modem or direct serial connections only, you do not 
have to install the TOPS TCP/IP module.  In that case, you may skip the following procedure.

1. Copy TOPS TCP/IP into the System folder. 

Copy onto your hard disk or a floppy, depending on what kind of system you have.  

Software installation is complete, except for restarting your Macintosh to install the TCP/IP 
module.  

2. Restart your Macintosh to install the TCP/IP module.

Ideally, your network has been set up with Kipper, a dynamic IP address server.  If Kipper is 
running on your network, TOPS TCP/IP will find an address for your Macintosh automatically 
every time you restart the Mac.  If the address is found, the TOPS Terminal logo will appear 
momentarily as your Macintosh is starting up and you will reach the Macintosh Desktop.  There is 
no need for you to do any further configuration.  You may now start TOPS Terminal, as explained 
in Chapter 1.  

If Kipper or another KIP server has not been installed on your network, you may see the following 
dialog window when you restart your Macintosh, in which case you may have to configure TOPS 
TCP/IP by hand: 

This indicates that you have installed TOPS TCP/IP in your system folder, but that necessary 
network information about your Macintosh is not available to TOPS Terminal.  To continue now, 
you have three choices:

•  Select Don't Install TOPS TCP/IP.

This means that you will not be able to use TOPS Terminal to log on to a computer on your local 
network.  You will be able to start up TCP/IP by configuring it from the Control Panel, as 
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described in “Setting Your Mac's Network Address” below.  Phone connections are not affected by 
TCP/IP.  

•  Select Try To Find a KIP Server.

This tells the Macintosh to look again for a KIP server which has your Macintosh's network 
address and other network information. 

•  Select Configure TOPS TCP/IP By Hand.

This involves providing the network address of your Macintosh, plus other configuration 
information.  See the instructions below.

Setting Your Mac's Network Address  

Note:  you can skip this procedure if you will be making phone connections only or if your 
network is using Kipper to automatically assign an address to your Macintosh.  System 
administrators should see Appendix G for a discussion of Kipper and instructions for installing it.  

1. Click on Configure TOPS TCP/IP By Hand.  

You will be asked to set the addresses of your Macintosh and your AppleTalk/Ethernet gateway (if 
you are using one), and subnet shift and size if appropriate on your network; see your system 
administrator if you have questions about these numbers.  

2. Type the IP address of your Macintosh.

Replace the first 0.0.0.0 with the IP address of your Macintosh.  An IP (Internet Protocol) address 
is composed of four numbers separated from one another by periods.  Get this number from your 
system administrator.

Use the mouse or press the Tab key to move the vertical cursor to the gateway box.

3. Type the gateway address.

Replace the second 0.0.0.0 with the IP address of your AppleTalk/Ethernet gateway.  Get this 
number from your system administrator, also.  
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4. Enter subnet shift and size, if necessary.

Check with your system administrator to see if you need to include subnet shift and size values; if 
so, enter the appropriate values.  Otherwise, uncheck the box labeled “Are subnets in use 
locally?”.

Assuming subnet shift and subnet size of eight, which is common, the dialog window will look 
like the following, with your Macintosh's address and gateway (if any) filled in: 

5. Click OK.  

You are finished setting up IP addresses for your Macintosh and its gateway (if any).  Check the 
address as described below, read “About this Manual” starting on page xvi, or go on to Chapter 1 
if you want to see how to start TOPS Terminal.  

Checking Your Mac's Network Address  

If you want to check that TOPS TCP/IP got these addresses right, do the following:  
1. Select the Control Panel Desk Accessory. 

Select the Control Panel, which is one of the accessories listed in the Apple () menu at the top 
left of the Macintosh screen.  
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The Control Panel will be displayed.  TOPS TCP/IP should be one of the entries.  (Resources are 
arranged alphabetically along the left side, so you may need to scroll downward to find TOPS 
TCP/IP.)  

2. Click on the TOPS TCP/IP icon.  

The Control Panel will display TOPS Terminal information.  The value for My Internet Address 
at the top right of the window should be the one you specified above.  

3. Change IP address, if necessary.

If the address isn’t correct (perhaps because you mistyped the address), you can change the IP 
address without having to restart your machine by clicking on the round  button to the right of the 
Internet Address.  The dialog window for entering your Mac's address and its gateway will 
reappear.  Enter the correct addresses and click OK.  

You can also enter a domain name by clicking on the My Domain Name button above the 
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Internet button.  A domain name gives a computer a name within a group of networks on the 
ARPANET.  An example is suntops.sun.com, which identifies the computer suntops in the 
subdomain sun in the subdomain com (commercial).  See your system administrator if you have 
questions about domain names.

4. Click the close box.

When you are finished, click the close box in the upper left-hand corner of the Control Panel.  See 
Chapter 1 for instructions for starting TOPS Terminal.

About this Manual

This manual contains information for three types of TOPS Terminal users:  those who want to use 
TOPS Terminal's basic functions, those who want to customize TOPS Terminal and use its more 
advanced functions, and those who will be administering a network of Macintoshes running TOPS 
Terminal.
If you are in the first category, use this manual to learn how to use TOPS Terminal and to refresh 
your memory about specific functions.  The material of most interest to you is the Introduction, 
Chapters 1 to 6, Appendix A, and Appendix H.  
If you are a more advanced user, you will refer to the material in Appendices B to F.  If you are 
responsible for assigning network and IP addresses, you will need to read Appendix G, the 
“System Administration Guide.”  
This section gives you an overview of the chapters and appendices in this manual and explains 
organizational and typographic conventions that have been followed.  

Manual Overview 

Introduction, “About TOPS Terminal,” is an overview of TOPS Terminal, with discussions of its 
primary functions and features, plus a description of TCP/IP (network protocols), and an 
explanation of how you can use TOPS Terminal with TOPS Network or other file server software. 

Chapter 1, “Getting Started,” shows you how to start and quit TOPS Terminal and describes 
some basic TOPS Terminal concepts and terms you need to know.  
Chapter 2, “Manual Connections,” leads you through two sample TOPS Terminal sessions:  a 
manual network connection and a manual phone connection.  
Chapter 3, “Automatic Connections,” shows you  how to create computer and account 
descriptions for making automatic connections to remote computers.  You also learn how to 
modify and remove computer and account descriptions.  Finally, you learn how to make automatic 
connections for various purposes, and about saving transcripts of terminal sessions.  
Chapter 4, “Terminal Emulation,” discusses terminal sessions, the primary type of connection you 
will make to a remote computer with TOPS Terminal.  In particular, you learn about using your 
Macintosh in terminal-emulation mode on a remote computer, and the functions that are available 
to you in the Network menu during terminal sessions.  Also included is an explanation of "power 
keys,” which give you keyboard equivalents for menu selections, mouse movements, and button 
pushes.  
Chapter 5, “File Transfers,” explains file transfer formats and file-naming conventions, and shows 
you how to copy files between your Macintosh and remote computers.  
Chapter 6, “Text Editing and Printing,” shows you how to edit text files — on your Macintosh or 
on a remote computer connected to your Macintosh with TOPS Terminal — and how to print 
those files.
Appendix A, “Quick Reference Guide,” displays TOPS Terminal menus, which include keyboard 
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equivalents for the menu functions, and gives you step-by-step summaries of TOPS Terminal 
functions.  
Appendix B, “Preference Settings,” describes the Settings menu selection, Your Preferences, 
which lets you set a number of TOPS Terminal variables, including printing font, display of full or 
short menus, and text wraparound during terminal sessions.  
Appendix C, “Modems,” tells you how to create, modify, or remove modem descriptions.  
Appendix D, “Scripts and Macros,” explains how to write, test, and edit scripts and macros to 
customize the interface between your Macintosh and other computers.
Appendix E, “Operating Systems & Services,” tells you how to create, modify, and remove 
operating system and service descriptions.  It also includes a graphic depiction of the hierarchical 
structure of TOPS Terminal.  
Appendix F, “Sign Up Files,” explains how to create and edit a sign-up file, a file that lists 
computers that can be used in account descriptions.  
Appendix G, “System Administration Guide,” provides technical information about IP addressing 
on your network; included are descriptions of subnetting, dynamic addressing, and the Kinetics 
FastPath gateway. 
Appendix H, “Trouble Shooting,” tells you what to do if something goes wrong while you are 
using TOPS Terminal.  
The Glossary lists and describes many of the networking and communications terms that are 
used to describe TOPS Terminal.  If you are uncertain about the meaning of a term encountered 
in the manual, look there for a brief definition.  
The Index at the back of the manual will help you find specific procedures and functions in the 
manual.

Organizational and Typographic Conventions 

Major Heading

Major headings are in 14-point, Italic bold type, underlined.  They 
are the major entries under chapter titles in the Table of Contents.

Secondary Heading

Secondary headings are in 12-point, Italic bold type; they appear in 
the Table of Contents indented under major headings.

Procedures you perform are indented one-half inch from left margin, 
numbered, and in bold type:  

1. Do this step.
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2. Read the text below this step.

Explanatory text often follows numbered steps, describing 
what you should see on the screen, explaining the logic behind the 
step performed, or explaining your options.  In some cases, you 
may be referred to another section of the manual for further 
information.

The names of menus, items in menus, and specific text from 
dialog windows are shown in Italics.  For example:

To describe accounts to be used for making automatic 
connections, you will select Accounts  in the Settings menu.  
Such text will be both bold and Italic when it is used in a procedure 
step:

3. Click Connect to start the connection process.

Bold type is sometimes used for emphasis within a sentence.
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TOPS Terminal Help

Besides this manual, there are two places to look when you have 
questions about TOPS Terminal:  on-line help and telephone help.  

On-line Help

On-line help is available for most TOPS Terminal functions.  In many 
cases there is a help button in a dialog window:  

Just click on the button to see an explanation of the particular 
function and a list of related help articles.  At other times there may 
not be a help button, but you can usually find out more about a 
subject by pulling down the Apple menu and selecting TOPS Terminal 
Help:  

You will see a list of basic help subjects:  
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Select an entry and click the Next button to read about the selected 
subject:  

There will usually be a list of related subjects, which you might want 
to read, also.  After you have read a few subject entries, you can 
trace your way back to where you started by selecting Back 
repeatedly:  

Select All Topics to see an alphabetic list of all help subjects.  Note 
that All Topics is always the last entry in the list of topics; you may 
have to scroll down the list to display All Topics.   Scroll through the 
list to find what you need and double click on an entry to read more:  

Click the Top button to go back to the help Introduction screen.  Click 
the Print button to print the current help entry.  When you are finished 
with help, click on the Quit button:  
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Introduction:
About TOPS Terminal

This introduction explains what TOPS 
Terminal is and describes its basic 
functions and features.  It also 
discusses network communications and 
TOPS Network software.  

Why TOPS Terminal?

The primary purpose of TOPS Terminal 
is to give you a simple way to connect 
your Macintosh to another computer so 
that you can use your Macintosh as if it 
were a terminal connected to the 
computer.  Two secondary purposes of 
TOPS Terminal are to make it easy for 
you to work on the remote computer 
once you are connected to it, and to 
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provide as many functions between the 
remote computer and your Macintosh  
as possible.  
TOPS Terminal accomplishes all three 
of these goals:  1) all you have to do to 
connect your Macintosh to a remote 
computer is describe the computer, 
describe an account on that computer, 
and select Terminal Session in the 
TOPS Terminal Network menu.  2) 
TOPS Terminal makes it easy for you to 
work on the remote computer by 
providing menus of commands and 
control-key functions that let you work 
on the remote computer even if you 
don't know anything about its operating 
system interface.  And 3) TOPS 
Terminal gives you two other major 
functions besides terminal emulation:  
file transfers between the remote 
computer and your Macintosh, plus a 
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full-featured text editor that you can use 
to edit files on your Macintosh or on the 
remote computer.  
Continue reading to learn more about 
why TOPS Terminal is needed, and how 
TOPS Terminal accomplishes its goals.

What is a Terminal?
To understand what TOPS Terminal is 
and what it does, it is useful first to 
understand what a terminal is and why 
you might want to have one.  A terminal, 
quite simply, is a device that lets you 
communicate with a computer.  The 
computer may be sitting on your desk in 
front of you, or it may be somewhere 
else (in the basement, across the street, 
or in another city).  Usually, a terminal 
consists of little more than a video 
display screen and a keyboard, although 
a more elaborate terminal may also 
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have a modem built into it and perhaps 
even a mouse or printer attached to it.
Computer terminals used to be much 
more common than they are today, and 
for good reason:  until recently, 
computer processors, memory, and disk 
storage devices were very expensive.  It 
made sense to centralize with large, 
expensive computers, known as 
mainframes, and later with smaller, but 
still expensive minicomputers.  By 
attaching inexpensive terminals to a 
central computer, a computing 
installation could greatly increase the 
number of people able to use the 
computer.  The common situation was 
thus to have many people using a single 
computer.

The Computer-Terminal Dilemma 
As prices for computer processors, 
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memory chips, and disks gradually 
decreased, many more people were 
able to afford entire computer systems 
of their own.  The Apple Macintosh and 
the IBM PC are two common examples 
of such systems, commonly known as 
personal computers, microcomputers, or 
desktop computers.  The typical 
situation with these kinds of computers 
is to have one person using one 
computer.  
The advent of desktop computers 
increased the amount of computing 
power available to the average user, but 
it drastically reduced file and data 
sharing, as well as the ability to 
communicate with other users that was 
common in a centralized, multi-user 
environment.
One solution to this dilemma was to 
write software that permitted personal 
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computers to pretend they were 
terminals, allowing one computer to 
connect to another over phone lines or 
over a direct serial cable.  A second 
solution was to create hardware and 
software that allow multiple computers 
to communicate and share resources 
among themselves over a local area 
network.  In these two different ways, a 
distributed computing environment was 
created, so that one person could now 
access the resources of many 
computers.  

The TOPS Terminal Solution 
With TOPS Terminal your Macintosh 
takes advantage of both of these 
schemes for sharing resources:  it can 
act as a terminal, able to access the 
processing power and disk storage of 
other computers, it can transfer files to 
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or from another computer, and it can 
edit files on another computer.  Thus 
TOPS Terminal allows your Macintosh to 
combine both terminal and networking 
functions.
The special advantage of TOPS 
Terminal over other solutions is that it 
gives you operating-system 
independence:  TOPS Terminal does all 
the remote-computer-interface work for 
you, allowing you to use the familiar 
Macintosh-style menu and screen 
operations for editing, file transfers, and 
making automatic connections to other 
computers.  
And you can maintain connections with 
several computers at once, using 
Macintosh file management and 
windowing capabilities.  TOPS Terminal 
thus allows you to accomplish much 
more than you could if you were using a 
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typical, “dumb” terminal.  You may think 
of TOPS Terminal not simply as another 
communications program, but as a high-
powered sessions manager that 
coordinates single or multiple 
conversations between your Macintosh 
and any number of other computers.  
TOPS Terminal also contains a full-
featured text editor, which you can use 
to edit files on your Macintosh or on a 
remote computer.  When you edit files 
on a remote computer, TOPS Terminal’s 
windowing capability allows you to open 
several files at once and to copy text 
from one file to another file.  TOPS 
Terminal's operating-system 
independence ensures that the the text 
you paste into a file on a remote 
computer adheres to the conventions of 
that computer's operating system.
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TOPS Terminal Basic Functions

TOPS Terminal performs three basic 
functions, which are described briefly 
here and discussed in detail in later 
chapters:

• Terminal Emulation
TOPS Terminal allows you to conduct terminal sessions on remote computers with your 
Macintosh, pretending that your Macintosh is any one of a number of kinds of terminals:  VT52, 
VT100, VT102, adm3a, and a simple (or “dumb”) terminal.  You can access the remote computer 
with a network connection or with a modem over a phone line.  

• File Transfer
TOPS Terminal allows you to copy files from a remote computer to your Macintosh or from your 
Macintosh to a remote computer.  File transfer can be performed with network or phone 
connections.  

• Editing and Printing
TOPS Terminal has a robust, Macintosh-style text editor built into it, which allows you to edit 
Macintosh text files without leaving TOPS Terminal.  The editor can also be used to edit a text file 
on a remote computer; the file is copied from the remote computer and opened as a TOPS 
Terminal editor document.  You then edit the file using familiar Macintosh editing operations such 
as selecting, copying, cutting, and pasting.  When you save the document, TOPS Terminal 
automatically copies the edited version of the file back to the remote computer, replacing the 
original file.    

You can, for example, edit a file on a UNIX system using the TOPS Terminal text editor.  Even if 
you are a novice computer user you can edit non-Macintosh files with ease, without having to 
learn a complicated text editor.

You can print a TOPS Terminal editor document (or selected portions of the document) while you 
are editing it with the TOPS Terminal editor or after you have ended the edit session.  You can also 
print a session transcript (or selected portions of it) during a terminal session on a remote 
computer.  Since the transcript of your terminal session is saved as an editor document by TOPS 
Terminal, you can also print it after you have logged off from the remote computer.  

TOPS Terminal Features

In addition to the three primary functions described above, TOPS Terminal has all the features 
that you would expect to find in a modern networking and communication software package, plus 
several others that are not so common:
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• Operating System Independence
TOPS Terminal provides a consistent and uniform user interface, regardless of the operating 
system the remote computer is running.  TOPS Terminal enables you to connect to a computer, 
execute commands, and disconnect from it by choosing the appropriate menu selections, without 
having to remember commands and control sequences of the operating system on the remote 
computer.  You can also add new operating system interfaces or customize the ones built into 
TOPS Terminal.  

• Automatic Connection - TOPS Terminal Memory
TOPS Terminal maintains a record of the computers that you connect to, and can, with a click of 
the mouse, connect to any of them automatically.  TOPS Terminal will connect to a remote 
computer using a user name and password that you have previously supplied.  If you select a 
remote computer that you connect to by phone, TOPS Terminal will automatically dial the 
appropriate number.  

Your descriptions of accounts and computers are saved in a file called TOPS Terminal Memory.  
The file is created when you first use TOPS Terminal and is updated every time you make any 
changes to computer or account descriptions.  TOPS Terminal uses this file to make connections to 
other computers; once you have set up your accounts you don't need to remember the settings, 
since the connection will be made automatically. 

• Multitasking 
One of TOPS Terminal’s strongest features is its ability to take full advantage of Macintosh 
windows to allow you to manage several conversations at once. You can, for example, connect to 
the same remote computer several times, or connect with several remote computers at one time.  
You can even establish a communications link to a remote computer over a phone line using a 
modem at the same time that you manage direct communications to one or more hosts on your 
local area network.   For instance, you could be in the middle of transferring a rather large file 
from a remote computer to your Macintosh in one window at the same time that you are reading 
your mail on a different computer in another window.  

TOPS Terminal is fully compatible with the MultiFinder and supports background file transfers.  

• Session Transcripts
TOPS Terminal retains the transcript of a terminal session in memory during the session, and 
saves the transcript as a file on your Macintosh unless you specify otherwise.  You can study the 
transcript, edit it, and print it after you have ended the connection with the remote computer. 

• Scrolling During a Terminal Session
Since TOPS Terminal retains the transcript of a terminal session in memory, you can scroll back 
and forth within the transcript, reviewing previous commands and the results of those commands.  
Besides giving you a historical record of the transcript, this reduces the need to have the remote 
computer break the output of commands into screen-sized pages. 

• Power Keys
Once you become familiar with TOPS Terminal, you can speed up your terminal sessions by 
taking advantage of numerous built-in “power keys.”  Some of these power keys are keyboard 
shortcuts that reduce your need to move your hands away from the keyboard to use the mouse to 
select menu items.  Other power keystrokes choose buttons in dialog windows.  

• Scripts and Macros
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Scripts and macros are kinds of programs that perform common tasks such as dialing up remote 
computers and automatically connecting to them.  TOPS Terminal has a number of scripts built in, 
and you can write your own, if you like.  

• Error-Correction
Phone lines and even direct-connect network cables are sometimes “noisy,” with the result that the 
data that one computer sends out may not always be exactly what the other computer receives. For 
this reason most communications programs employ some method of making sure that the data 
transfer is being accomplished reliably and without error.  The particular way that a program does 
this is called its “error-correction protocol.”  TOPS Terminal employs an error-correction protocol 
known as TCP when operating over a network, and XMODEM when transferring files over phone 
lines. 

Communications Protocols

To communicate across a network or an interconnected group of networks (called an “internet”), 
TOPS Terminal uses a set of languages or protocols known as the Internet Protocol suite, or 
more commonly as TCP/IP.  This allows your Macintosh to communicate with any remote 
computer that supports the TCP/IP protocols, without making any modifications to the remote 
computer’s operating system.  
A number of network services can be built on top of TCP/IP protocols.  The two most common 
services provided by a network communications package are terminal emulation and file 
transfers, both of which are described below, after the discussions of TCP/IP.  

TCP/IP - the Network Communicator

TCP/IPgets its name from the fact that TCP and IP are the two most commonly utilized protocols 
in the Internet suite.  IP is the Internet Protocol; it sends “packets” of network data to other 
computers, but does not guarantee their ordering or correctness.  TCP (the Transmission Control 
Protocol) makes sure that network transmissions arrive at their assigned destination intact.  It 
monitors what is sent into the network and  arranges to re-transmit any data packets that do not 
arrive correctly.  TCP is also responsible for breaking large network transmissions into bite-sized 
packets, called “datagrams.”  
TOPS Terminal allows your Macintosh to speak TCP/IP and thereby to perform the numerous 
network operations that are built on top of TCP/IP.  TCP/IP protocols can be used to communicate 
across quite different types of physical networks.  TOPS Terminal operates over Ethernet alone 
(for those Macintoshes that have a direct Ethernet connection) or over a combined Local 
Talk/Ethernet network (bridged by a Kinetics FastPath gateway or other connective hardware). 
TCP/IP demands only that the network it operates over be a “packet-switching” network.  This 
means that data transmissions from every computer on the network are broken up into small 
packets and sent out over a single network wire.  Each packet is labeled with the address of its 
destination (provided by IP) and a number that allows the remote computer to detect whether the 
packet has been damaged in transit (provided by TCP).    

TELNET - Network Terminal Emulation

Network terminal emulation, or the ability to use your local computer as if it were a terminal 
directly connected to a network host, is provided by a further protocol known as TELNET.  
TELNET services are built on top of the underlying TCP/IP protocols.  
In TOPS Terminal, TELNET services are provided by the Terminal Session command under the 
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Network menu.  Once you have successfully opened a terminal session on a remote network 
computer (which can be handled automatically by TOPS Terminal), characters typed in a session 
window on your Macintosh are sent to the remote computer.  When connected to the remote 
computer your Macintosh behaves exactly as if were a terminal connected directly to that host.  
(TOPS Terminal provides additional capabilities not possible with a standard terminal, as 
described in “TOPS Terminal Features” above.)

FTP - File Transfer Protocol

File Transfer Protocol (or FTP for short) defines a protocol for transferring  files to and from any 
network computer that the user has permission to access.  Like TELNET, FTP services are built 
on top of the underlying TCP/IP protocols.  
In TOPS Terminal, FTP services are provided by the File Session command under the Network 
menu.  Once you have successfully opened a file transfer session on a remote computer, you can 
use the Send File and Receive File commands in the Network menu, as well as other TOPS 
Terminal menu functions.  The details of FTP file transfer are displayed in the file session window; 
the transcript of this conversation between the two computers might be useful if there are any 
problems with the transfer.

XMODEM - Phone-Connection Protocols

For communications between modems over phone lines, TOPS Terminal employs XMODEM 
protocols, which provide terminal session services only; phone-connection file transfers must be 
accomplished during terminal sessions, and not during file sessions as they are for network 
connections.  

TOPS Terminal and TOPS Network

If you are using TOPS Terminal in conjunction with TOPS networking software, you can derive 
additional benefits.  You can use TOPS Terminal’s built-in text editor to edit files mounted from a 
remote TOPS server.  For example, you can edit IBM PC text files on your Macintosh if you have 
mounted the PC directory as a local Macintosh volume.  
If you are using the TOPS networking software, you can also effect “third-party” file transfer by 
using TOPS Terminal to copy files from a TOPS server to a network computer that is not running 
TOPS.  You can copy a file from an IBM PC or a Sun Workstation running TOPS to a mainframe 
connected to the network by mounting the PC or Sun directory as a TOPS volume on your 
Macintosh and using the Send File command in TOPS Terminal.  Similarly, you can copy a file 
from the mainframe to a Sun or a PC running TOPS:  mount a directory from the Sun or the PC 
as a TOPS volume on your Macintosh and execute the Receive File operation from TOPS 
Terminal.  
Chapter

1
Getting Started

newpath
72 144 moveto 0 9 rlineto 0 -9 rmoveto 9 0 rlineto
72 756 moveto 0 -9 rlineto 0 9 rmoveto 9 0 rlineto
468 144 moveto 0 9 rlineto 0 -9 rmoveto -9 0 rlineto
468  756 moveto 0 -9 rlineto 0 9 rmoveto -9 0 rlineto
stroke



This chapter explains how to start up and 
quit TOPS Terminal, explains some basic 
TOPS Terminal concepts and terminology, 
and describes the primary TOPS Terminal 
menus.  

S  tarting Up & Quitting TOPS Terminal  

Startup
Once the software has been installed, as described in the Preface, 
you are ready to run TOPS Terminal.  

1. Double click on the TOPS Terminal icon.

This will start up TOPS Terminal.  If you have not run TOPS Terminal before, you will see the 
following box:

Help screens are available from almost anywhere in TOPS Terminal, as explained in the Preface.  
If you were to click on the Help Me box, you would see a list of help topics to choose from.  To 
continue the startup process, do the following:

2. Click Don’t Help Me.  
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You will see the TOPS Terminal startup logo in the center of the screen, with four of the TOPS 
Terminal menus — File, Edit, Network, and Settings — listed at the top:

You are now ready to use TOPS Terminal for terminal emulation, file transfers, or document 
editing.  See Chapters 2 to 6 for detailed explanations and instructions.  
Quitting TOPS Terminal
When you are finished working with TOPS Terminal:

1. Select Quit in the File menu:

Normally you will log off from remote computers and close all session windows by clicking on 
the close box before quitting.  In that case, TOPS Terminal will close all its files and processes and 
return you to the Macintosh Desktop (unless you are using MultiFinder).  

If you quit TOPS Terminal without logging off from a remote computer connection, which is not 
recommended, you will be asked if you really want to terminate the connection:  
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2. Click Yes or No.  

If you have not saved changes to an editor document or to a session transcript that was being 
saved, you will be asked if you want to save the changes:

3. Click Yes or No.  

Unless other sessions are active or unsaved files are open (or unless you are using MultiFinder), 
you will be returned to the Macintosh Desktop.

To learn about TOPS Terminal concepts, terminology, and conventions, continue reading below.  
If you are anxious to start using TOPS Terminal, skip ahead to the locations noted in parentheses:

•  Making a manual connection to a remote computer (Chapter 2)
•  Creating computer and account descriptions for automatic 
    connection to a remote computer (Chapter 3)
•  Automatically connecting to a remote computer (Chapter 3)

What You Need to Know 

A number of concepts and terms are discussed below, with the idea that this background will 
make it easier for you to understand TOPS Terminal and its capabilities:  

•  Automatic connections and accounts
•  Network accounts and phone accounts
•  TOPS Terminal Memory
•  Windows 
•  Session transcripts
•  File Naming

See the Glossary at the back of this manual for explanations of additional concepts and terms.  
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Automatic Connections and Accounts

One of the most important features of TOPS Terminal is that it enables you to log on to remote 
computers automatically, and, once you are logged on, to perform various terminal emulation, file 
transfer, and document editing functions without being familiar with the operating system of the 
remote computer to which you have logged on.  
To prepare for an automatic connection to a remote computer, therefore, you must not only 
provide TOPS Terminal with login information, but also with information TOPS Terminal needs in 
order to interface with the computer's operating system.  This preparation entails creating an 
account description, which is then used to automatically connect to a remote computer.  In 
creating the account description (see Chapter 3), you tell TOPS Terminal how to interface with the 
remote computer.  
TOPS Terminal then provides you with a number of terminal and file transfer services, which are 
part of an operating system description.  You can use TOPS Terminal menus during terminal 
emulation sessions on a remote computer, and you can transfer files or edit documents, without 
knowing the details of how TOPS Terminal interfaces with the remote computer's operating 
system.  
TOPS Terminal includes descriptions of several of the most common operating systems.  To learn 
how to create new operating system descriptions or customize existing descriptions and to see a 
graphic depiction of the hierarchical structure of TOPS Terminal, see Appendix E. 

Network Accounts & Phone Accounts 

The terminal and file transfer services provided by TOPS Terminal depend on whether the 
connection between your Macintosh and the remote computer is a network or phone connection.  
Network connection:  one made to a remote computer located on a network that you can reach 
without using a modem attached to your Macintosh.  In most cases such a network is a local area 
network located in the same building as your Macintosh and physically attached to the same 
network cable.  In other cases one or more of your computers may be connected to a wider 
network community (or Internet) such as ARPANET; to TOPS Terminal this represents a network 
connection, even if phone lines and modems are involved — as long as your personal modem is 
not being used.
Phone Connection:  one made through a modem attached directly to your Macintosh or one 
shared by your AppleTalk network (Shiva NetModem, for instance).  
Because of differences between the communications protocols used by network and phone 
connections, some TOPS Terminal functions work differently, depending on whether you are 
using a network or phone account to make an automatic connection to a remote computer.  The 
differences are summarized in the table below:

Function to Perform    TOPS Terminal Service to Use
Network Account Phone Account

Terminal Emulation Terminal Session Terminal Session

File Transfer File Session Terminal Session

Remote Editing File Session Not available

As you can see from the table, terminal emulation is accomplished with terminal sessions for both 
network and phone accounts.  File transfers, however, are performed differently for the two types 
of accounts.  Specifically, network account file transfers are performed during file sessions, with 
FTP (File Transfer Protocol) available to make the process very simple.  Phone account file 
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transfers are performed during terminal sessions; you log on to the computer, start up a transfer 
process on the remote computer, and then do the transfer from TOPS Terminal.  

TOPS Terminal Memory

TOPS Terminal Memory is the file where TOPS Terminal stores descriptions of accounts, 
computers, operating systems, and services that you create or modify.  The file is kept in your 
System folder.  Since it contains important information that you will use regularly for making 
automatic connections to remote computers, you should back it up to a floppy disk whenever you 
make changes to it.  

Windows 

Whenever you start a terminal session or file session, or when you edit a document, you open a 
TOPS Terminal session window.  These windows, like most Macintosh windows, can be moved or 
sized, and you can scroll in a window by using the scroll arrows and scroll bars.  
The kind of TOPS Terminal window displayed (terminal session, file session, editor document, 
editing a macro or script) is indicated by a status box in the lower left corner of the window.  
To move a window, position the pointer in the title bar at the top of the window (the pointer will 
become a hand), hold down the mouse button, and move the mouse.  Note that many of the 
TOPS Terminal dialog windows can be moved in the same way.  
To change the size of a session window, position the pointer in the size box at the lower right of 
the window (the pointer will become a hand), hold down the mouse button, and move the mouse 
to shrink or expand the size of the window.  Click on the zoom box at the top right of a window to 
toggle between a full-size and a smaller window.  
You may open several terminal or file session windows at once, making several connections to 
the same computer or separate connections to several computers (you can only make one phone 
connection at a time, however).  You can open a number of editing windows, as well.  
Although you can open a number of windows at one time, you can only work in the 'active' 
window — the one in the foreground.  There are two ways to bring a background window to the 
foreground:  if the window you want to switch to is partially visible behind the active window, click 
anywhere in the window you want to move to; the selected window will move in front of any 
windows that were previously covering it, and it will become the active window for any keyboard 
or mouse functions.

If the window that you want to move to is obscured by other windows, you can bring it to the 
foreground by using the Windows menu. When you click and hold on the menu, you will see a list 
of all the windows currently open; for example:

To select a window, click and hold while moving the mouse until the window you want is 
highlighted; then release the mouse button to bring the selected window to the foreground.

Session Transcripts 

When you connect to a remote computer, all that you type, plus the remote computer's 
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responses, are displayed in a session window.  During a session, the status box at the bottom-left 
of the session window reads “Connected to [name of computer].”
Some or all of what appears in the session window remains in memory on your Macintosh during 
a terminal session; that which remains in memory is the session transcript.  A check box in the 
Description of an Account dialog window and the two Network menu commands, Clear Lines Off 
Top and Capture Lines Off Top, determine whether all or part of what is displayed during a 
session remains in memory.  The Don't Capture Lines Off Top check box is explained in Chapter 
3; the two Network menu commands are described in Chapter 4.
A session transcript may or may not be saved to a disk file, depending on choices you make 
when you describe an account, when you select an account to start a terminal session, during a 
terminal session, or after you log off from a remote computer.  Saving session transcripts to disk 
is discussed in Chapter 4.
When you log off from a remote computer during a terminal or file session, a session transcript 
becomes an editor document — a document that can be edited with the TOPS Terminal editor.  
The status box at the lower-left of the session window changes from “Connected to [computer 
name]” to “Editor Document.”  Editing is discussed in Chapter 6.  

File Naming

When you name files within TOPS Terminal, you should be aware of the naming conventions for 
the system you are working on.  The chart in Chapter 5 gives you a brief summary of naming 
conventions for UNIX, VMS, and Macintosh operating systems.  Note especially the special 
characters that are not allowed on the various systems:  slashes, asterisks, question marks, and 
other special characters on UNIX; colons on Macintosh; just about any special character except a 
hyphen on VMS.  
Note:   TOPS Terminal automatically creates terminal session transcript names that include 
slashes as part of the date; since slashes are not allowed on UNIX systems, you will have to 
rename these files before copying them to a UNIX computer (unless you copy them with TOPS).

TOPS Terminal Menus

The Apple menu and four primary TOPS Terminal menus are available when you start TOPS 
Terminal:

When you are connected to a remote computer or when you are editing a file, two additional 
menus — Windows and Text— will be available.  

See brief descriptions of each menu below, and further explanations throughout the manual.  
Select an item in a menu as with any Macintosh application:  move the arrow cursor to the menu 
you want to select, click and hold the mouse button while you move the mouse down until the 
item you want is selected, and release the button.

File Menu

The File menu looks like a standard Macintosh File menu:
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The TOPS Terminal File menu has a few extra functions, though, including Revert to Saved 
(restores file to its state at the time you last saved the file), Save Selection (saves selected text to 
a new file), Print Selection (prints selected text), and Print Many (selects a number of files to print 
in succession).  
Use the File menu to create new text files or open existing text files for editing, and to print these 
files.  See Chapter 6 for details about editing and printing from TOPS Terminal.  You can also use 
the File menu to create or edit sign-up files, as described in Appendix F.  

Edit Menu

The Edit menu, like the File menu, looks like a standard Macintosh menu: 

Use the Edit menu to edit text files within TOPS Terminal.  You can use the standard Macintosh 
procedures to Cut or Copy selected text from one location in a document and Paste it in a new 
location; you can change windows to copy text between two or more different documents or 
session transcripts.  See Chapters 3 and 4 for details about session transcripts, connecting to 
remote computers, and changing windows.  See Chapter 6 for more about editing text files.

Network Menu 

The Network menu is used to make connections to a remote computer and to perform functions 
while connected to the remote computer.  It is a specialized TOPS Terminal menu, with short and 
full versions (the display of short or full menus is determined by a setting in Your Preferences, 
explained in Appendix B).  The short version, which is what you see when you first start up TOPS 
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Terminal, provides eleven options:  

The primary uses for the Network menu are to:
•  Establish a terminal or file session on a remote computer
•  Send files to a remote computer 
•  Receive files from a remote computer
•  Edit files on a remote computer.

See Chapters 3 and 4 for more about establishing a terminal or file session on a remote computer 
and what you can do once the session is established, Chapter 5 for details about sending and 
receiving files, and Chapter 6 for information about editing files on a remote computer.
During a terminal session, the Network menu is also used to:

•  Send text from a Mac file to a program on a remote computer 
•  Interrupt the execution of a function on a remote computer
•  Clear or capture lines of text from the top of a session transcript
•  Issue commands on a remote computer
•  Execute control-key sequences on a remote computer

See Chapter 4 for details about those functions, and Appendix B for a discussion of the full 
Network menu.

Settings Menu 

The Settings menu is also a specialized TOPS Terminal menu, with short and full versions (the 
display of short or full menus is determined by a 
setting in Your Preferences, explained in Appendix B).  The short menu has four entries:

Use the short version of the Settings menu to:
• Describe computers that you wish to connect to 
• Describe accounts for automatic connections to remote computers
• Specify a modem type and phone settings 
• Specify your preferences while using TOPS Terminal
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See Chapter 3 for instructions for creating computer and account descriptions and Appendix B for 
a description of Your Preferences, including a discussion of the full Settings menu.

Windows Menu

The Windows menu, which shows you what windows are open in TOPS Terminal, is similar to the 
Window or Windows menu in other Macintosh applications:

Use the Windows menu to switch back and forth between windows in TOPS Terminal.  See 
Chapter 4 for a discussion of session windows and Chapter 6 for information about TOPS 
Terminal editing windows.

Text Menu

The Text menu, which is available once you have opened an edit document or established a 
terminal session, is similar to the Search menu in other Macintosh applications, and is primarily 
used to find or replace typed or selected text:

The find and jump functions can be used while using the TOPS Terminal editor or during a 
terminal session, but the shift and replace functions can only be used in an editor document.  See 
Chapter 4 for information about terminal sessions and Chapter 6 for detailed descriptions of all 
editing functions.

Dialog Window Conventions

The standard way to activate a function in a TOPS Terminal dialog window (a window on the 
screen to which you are expected to respond) is the same as for most Macintosh applications:  
use the mouse to move the arrow cursor to an item you want to select, click the mouse button to 
select the item, and click on an action button to perform some function (such as opening a file).  
But as with many other Macintosh applications, TOPS Terminal gives you optional ways to do 
things.

Using the Keyboard or the Mouse 

You can always use the mouse to move around the window and select items in a list or click on 
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an action button.  But you may sometimes find it more convenient to use the keyboard for some 
of these functions.  In this section we talk about the tab key, arrow keys, and the default button 
in a dialog window.  See “Power Keys” in Chapter 4 for an explanation of more complex things 
you can do from the keyboard.  
Tab Key
If there is more than one text box in a dialog window, you can move from one box to the next by 
pressing the Tab key.  In the Description of a Computer, for instance, the Tab key moves from 
computer name to its location to its TCP/IP address, and finally to the TCP/IP timeout.  

Arrow Keys
When there is a single list of items to choose from, the arrow keys will move from one item to the 
next (down with down arrow, up with up arrow), selecting each item successively.  

Default Button
When TOPS Terminal presents a dialog window requesting that you do something, there are 
usually some action buttons on the screen for you to choose from.  You can use the mouse to 
click the desired button, or, if the button you want to click is the default button — the button with a 
thickly outlined box — you can press the Return or Enter key.  The button indicating that you are 
finished with a dialog window — OK or Done — is usually the default button, as in the example 
below.  
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If, however, some other button in the dialog window has a thick outline around it, the Return or 
Enter key selects that option.  

Select and Click or Double Click 

In most cases you can either select and click or double click to perform a function on TOPS 
Terminal.  If you want to open the computer description Suntops, for instance, in the following 
dialog window:

You could use the mouse to move the arrow cursor to the Suntops line, click on the mouse button 
to select Suntops, and then move the cursor to the Open button and click the mouse button to 
open the description of Suntops.  But an alternative way to do the same thing is to move the 
cursor to the Suntops line and double click the mouse button.  A double click indicates that you 
want to select Suntops and to do whatever the default button says (Open, in this case).

Selecting From a List

Sometimes TOPS Terminal provides you with a list of choices, such as a list of available 
computers or a list of available accounts, from which you need to select a single choice.  If there 
are no text boxes for you to fill in, you can select a list item from the keyboard by typing the letter 
that your choice begins with.  To select TOPS BBS from the list of computers below, for instance, 
just press the letter T and TOPS BBS will be selected:
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(If there were two computers that started with T, you could select the second one by pressing the 
first two letters of the computer name in rapid succession.)  

Multiple Choices in a List

There are two ways to select more than one item in a list.  To select a group of contiguous items 
in a list, select the first item, then hold down the Shift key and select the last item in the group:  

To select two or more noncontiguous items in a list, hold down the Option and Clover ( )⌘  keys 
together and click on the items one at a time.  If your modem works at 300, 1200, or 2400 baud, for 
instance, you can select all three speeds:

A Note About Upper and Lower Case

As with many Macintosh applications case is generally ignored in TOPS Terminal; file, computer, and 
account names are case-insensitive.  The file name “XYZ” is the same as the file name “xyz.”  

Chapter
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2
Manual Connections

This chapter walks you through two manual 
connections — one to a computer on a local 
area network and one to a computer dialed 
up over a phone line. 
Note:  because many more functions are 
available with automatic connections, you 
will normally be making automatic 
connections to remote computers — 
selecting an account you have previously 
created, clicking Connect, and sitting back 
as TOPS Terminal automatically connects 
you to a remote computer.  Manual 
connections are discussed first because 
they may allow you to see TOPS Terminal in 
action a little sooner the first time you use it. 
Skip ahead to Chapter 3 if you want to learn 
about automatic connections.
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To make a manual connection to a 
computer on a local network, follow the 
instructions below.  To make a connection 
using a modem, see “Making a Manual 
Phone Connection” on page 24.  

Making a Manual Network Connection 

This section shows you how to use TOPS 
Terminal to log on to a remote computer on 
your local network.  To make this manual 
connection TOPS Terminal needs the 
following information:

•  IP address of your Macintosh (See 
Preface)

•  Type of terminal to emulate
•  Network name or address of the 

remote computer 
•  Your user name and password (if any) 

on the remote computer
After starting TOPS Terminal, do the 
following to make the manual connection:

1. Select Terminal Session in the 
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Network menu.

The Account Selection dialog window will be displayed and you will be asked to select an account 
to use to log on to the computer.  Normally, only two choices — Manual Phone and Manual 
TCP/IP — will be listed when you first use TOPS Terminal, and Manual Phone will probably be 
“grayed out,” indicating that you cannot select it because it is disabled:

Note the network connection icon to the left of the account name:

  

2. Select Manual TCP/IP.

Use the mouse or the arrow keys to select Manual TCP/IP if it is not selected.  When you select 
Manual TCP/IP you are telling TOPS Terminal that you will not be logging on automatically, but 
will be providing information about the connection as it is requested.

Note:  if the selection Manual TCP/IP is not enabled, it is probably because you did not install 
the TOPS TCP/IP module in your System folder, as described in “Software Installation” in the 
Preface.  
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3. Click Connect.

This tells TOPS Terminal to begin the account connection process.  You are first asked what kind 
of terminal should be emulated:

4. Select a terminal type and click OK.

You can press Return to select the default terminal, the VT100; select another terminal in the list, 
if appropriate.  

Note:  The Terminal-Type question means “What kind of terminal does the remote computer 
think you are using?”  If you see some strange-looking characters when you are logging on, the 
terminal type you chose may have been incorrect or your account may have been set up 
improperly on the remote computer; see your system administrator. 

You will next be asked to pick the remote computer to call from a list of computers, or to fill in the 
computer's network (IP) address.  If this is your first use of TOPS Terminal, there will probably be 
no computers listed.   You will have to provide an IP address, which is comprised of four sets of 
digits, separated by periods.  See your system administrator if you do not know this number.

5. Type in the IP address and click OK.
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In the example shown below the address (131.131.5.3) is for “Suntops,” a Sun Workstation on our 
local network running the UNIX operating system.

TOPS Terminal will open a session window and attempt a connection to the remote computer.  
When the connection succeeds, you will see a normal login prompt in the window.  In this 
example we are connecting to a UNIX system:  

6. Log on to the computer in the normal way.

To gain access to the other computer, you may have to specify a user name (in this example, 
dave) and a password.  
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7. Execute some commands on the computer

When you have made the connection and logged on you can execute commands on the computer 
exactly as if you were sitting at a terminal attached to the computer. 

8. Log off from the computer in the normal way.

Type logout (or whatever the appropriate command is for the computer you actually connect to).  

9. Click the close box at upper left of session window.

This will terminate the connection.  The session window will disappear and the TOPS Terminal 
menu bar will be displayed.  

You have completed the manual network connection.  Try the manual phone connection that 
follows, if you like, or go on to Chapter 3 to see how to create computer and account descriptions 
which will allow you to make automatic connections to remote computers.

Making a Manual Phone Connection 

If you have a Hayes or Hayes-compatible modem connected to your Macintosh you can use 
TOPS Terminal to manually connect to a remote computer over a phone line (if the computer has 
a modem attached).   In the following example you are shown how to make a connection to the 
TOPS Talk Bulletin Board System (an information service about TOPS products).
To make this manual connection TOPS Terminal needs the following information:

•  Type of terminal to emulate
•  Baud rate of modem
•  Telephone number of the remote computer's modem 
•  Your user name and password (if any) on the remote computer

After starting up TOPS Terminal:
1. Select Modem from Settings menu
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(If you selected a modem previously, skip steps 1 and 2.)

2. Select a modem type and click OK.

(You need to select a modem type or all modem accounts will be disabled; that is, when you select 
Terminal Session in the Network menu, Manual Phone and any other phone accounts will be 
“grayed out,” indicating that they cannot be used.)

3. Select Terminal Session in the Network menu.
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The Account Selection dialog window will be displayed and you will be asked to select an account 
to use to log on to the computer.  Normally, only two accounts — Manual Phone and Manual 
TCP/IP — will be available when you first use TOPS Terminal:

Note the phone connection icon to the left of the account name:

4. Select Manual Phone.

Use the mouse or the arrow keys to select Manual Phone if it is not selected.  When you select 
Manual Phone you are telling TOPS Terminal that you will not be logging on automatically, but 
will provide the remote computer's modem phone number and other information when it is 
requested.

5. Click Connect.

This tells TOPS Terminal to begin the account connection process.  

(Note that you could instead double click on Manual Phone, or, since Connect is highlighted, 
press Return to start the dialog.)

Next you will be asked to name the file where the session transcript will be saved.  TOPS Terminal 
will generate a name automatically, using the account name plus today's date and a number; you 
can change the name by typing in something else.  
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(If you tried the manual network connection in the previous section you may recall that you were 
not asked this question — because that account was set up so that session transcripts are not saved. 
See “Modifying an Account Description” in Chapter 3 to learn how to tell TOPS Terminal whether 
or not you want to save session transcripts.)  

6. Type a different file name (optional). 

Type in a file name, if you do not want to use the name automatically generated by TOPS 
Terminal.

7. Click Save.

This tells TOPS Terminal to save a transcript of the terminal session — your keystrokes plus the 
computer's responses — in the file you specified.

TOPS Terminal then asks you what kind of terminal you wish to emulate:

Note:  If you see some strange-looking characters when you are logging on, the terminal type you 
chose may have been incorrect or your account may have been set up improperly on the other 
computer; see your system administrator. 

8. Select a terminal type and click OK.

Just press Return to select the default terminal, the VT100; select another terminal in the list, if 
appropriate.  
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You will then be asked the baud rate of your modem:

9. Select a baud rate and click OK.

This is the baud rate for the modem that is attached to your Macintosh (probably 1200 or 2400).  

A new, empty session window will be drawn, with a cursor in the top-left corner:

10. Type ATDT, phone number, and press Return.

This tells your modem to call the phone number you specify.

If you don't have a computer to call, try the following, which is the number for the TOPS Talk 
Bulletin Board System (TOPS BBS):  

AT D T  5 5 5 - 1 2 1 2  [Return] 

Note the following when you try to make this connection:

•  Outside the 415 area code, type:

AT D T  4 1 5 - 5 5 5 - 1 2 1 2  [Return] 

•  If you need to dial 9 for an outside line, type:
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AT D T  9 , 5 5 5 - 1 2 1 2  [Return]  

Include 415 if outside the area code.  The comma after the 9 is a pause signal, giving the phone 
time to get a dial tone before dialing the rest of the number.  

(Also note that this number is often busy; you may have to close the connection and start over 
again at step 3 if the line is busy; wait 30 seconds before you try again or power cycle your 
modem between attempts.  Otherwise your modem may still be trying to make the connection 
when you try again.)

(If your keystrokes are not displayed in the session window, something is wrong:  

 •  Do you have a modem connected to your Macintosh?
  •  Is the modem turned on?
  •  Did you specify the correct baud rate in step 9?
  •  Does the status box at the lower-left of the window say 
     “Connected to Manual Phone”?

If the answer to any of those questions is No, you will have to close the connection — by clicking 
on the close box at the top-left of the window — and start the process over at step 3 above.  If you 
know what the problem was, correct it before you start over:  turn the modem on if it was off; 
select a different baud rate in step 9, if that was the problem; turn the modem off and then on to 
recycle it if it was on.)

11. Press Return when you see the response CONNECT.

(This step may vary, depending on what modem you have and what system you are connecting to.) 

Here is the dialing sequence and connection dialog for connecting to TOPS BBS:  

The title bar at the top of the terminal session window shows the name of the current document; 
this is the file in which the text of the current session is being saved.  In the lower-left corner is the 
window status; here it shows a connection to the computer named Manual Phone. 

12. Log on to the computer in the normal way.

You now need to identify yourself to the computer by typing in your user name and a password, if 
any.  If you are dialing in to TOPS BBS, you will be asked for your first name, last name, and a 
password.  If this is your first time calling TOPS BBS you can enter any password, which will 
become your regular password on the system.  

Once you are logged on to TOPS BBS or another computer, you can run commands on it exactly 
as if you had dialed it up using a standard terminal and modem.  

TOPS BBS is mostly self-explanatory.  The general rule on TOPS BBS is to press the space bar to 
read additional screens of messages and to press the escape key to interrupt whatever you are 
doing and return to the main menu.  If you do not have an escape key (esc) on your keyboard you 
can simulate an escape-key press by using the Clover key ( )⌘  and the backward single quote key 
together.  See “Your Preferences” in Appendix B for details about simulating an escape key press.  
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The Main Menu on TOPS BBS lists a number of functions which you can perform by pressing a 
single letter.  Try some of them if you like.

13. Log off from the computer in the normal way.

On TOPS BBS type the letter g to log off; you have to be at the TOPS BBS main menu.  You may 
have to press the escape key (esc), Clover-C ( -C)⌘ , or Clover-Shift-C to reach the main menu.  

14. Click the close box at upper left of session window.

You will be asked if you want to terminate the session:

Note:  You are not asked this question when you terminate a network connection after logging 
off.  This has to do with the sequence of characters that must be sent to a modem to tell it you want 
to disconnect.  

15. Click Yes.

16. Click the close box again.

This will terminate the connection.  TOPS Terminal will respond with a warning:

17. Click Yes or No.

Click Yes to save the transcript of the terminal session, No if you do not want to save the 
transcript.  See page 8 for a discussion of session transcripts.

The session window will disappear and the TOPS Terminal menu bar will be displayed.  (If you 
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have another terminal session window open, it will be displayed when the top window is closed.)

You have completed the manual phone connection.  See Chapter 3 on the following page to see 
how to create computer and account descriptions for making automatic connections.

Chapter

3
Automatic Connections

When you make an automatic connection to a remote computer with TOPS Terminal, you can 
perform a variety of terminal emulation, file transfer, and document editing functions on the 
computer, even if you don't know anything about the computer's operating system.  To prepare for 
an automatic connection, you first create a computer description for the remote computer and 
then you create an account description for logging on to that computer.  
This chapter explains how to create, modify, and remove computer and account descriptions, and 
how to make automatic connections to remote computers.  Chapters 4, 5, and 6 explain the 
TOPS Terminal services available after you make an automatic connection:  Chapter 4 describes 
terminal emulation, Chapter 5 file transfers, and Chapter 6 text editing and printing.  
To automatically connect to a remote computer TOPS Terminal needs:

• A computer description 
-  Computer's network address or phone number
-  Computer's operating system
-  Modem and phone information (for phone accounts)

• An account description 
-  Computer to connect to
-  Type of terminal to emulate
-  Your user name on the computer 
-  Your password on the computer (optional)  

See your system administrator if you do not have all the information required to complete the 
following procedures.  

Overview of Automatic Connections

This chapter includes information you need to prepare for and make an automatic connection to a 
remote computer.  The process generally follows this pattern:  

1. Create a computer description.  

See “Creating a Computer Description” below for details.  The computer description tells TOPS 
Terminal what operating system the computer uses and how the connection will be made (network 
or phone).  Computer descriptions for network and phone connections are discussed separately.  

newpath
72 144 moveto 0 9 rlineto 0 -9 rmoveto 9 0 rlineto
72 756 moveto 0 -9 rlineto 0 9 rmoveto 9 0 rlineto
468 144 moveto 0 9 rlineto 0 -9 rmoveto -9 0 rlineto
468  756 moveto 0 -9 rlineto 0 9 rmoveto -9 0 rlineto
stroke



2. Create an account description.

See “Creating an Account Description” on page 44 for details.  An account description is what you 
use to make an automatic connection.  It includes the name of the remote computer specified in 
your computer description as well as your login identification on that computer.  

There are three ways to link a computer description to an account description:  choose it from your 
TOPS Terminal Memory, choose it from a sign-up file, or create a new computer description as 
you create the account description.  If you are not sure about which of these methods to use, check 
with your system administrator.  Each method is described separately below.  

3. Make an automatic connection.  

See “Making an Automatic Connection” on page 56 for details.  Once you have made the 
connection, you can perform terminal emulation, file transfer, or document editing functions on 
the remote computer; these functions are explained in Chapters 4, 5, and 6.  

If you want to modify or remove computer or account descriptions, see the sections that explain 
those procedures.  Pay special attention to “Modifying an Account Description” on page 68, since 
that section includes information about session transcripts and passwords.  

Creating a Computer Description

As explained in Chapter 1, there are two kinds of connections with TOPS Terminal:  network and 
phone.  Each type of connection is explained separately below.  

Network Connection

To create a computer description for a remote computer on your network, do the following after 
starting up TOPS Terminal:

1. Select Computers from Settings menu.

The list of known computers will be displayed; if you have not created any computer descriptions 
and none have been copied from a sign-up file, no computers will be listed:  
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2. Click the New button.

A blank Description of a Computer will be shown:

Note:  the short version of the computer description is shown here; if you selected a modem type 
in Chapter 2, phone connection information will be included at the bottom of the description.  
Since you are describing a computer with no phone connection, ignore that information.  

3. Type the computer's name.

This is the name by which the computer is known on the network.  Check with your system 
administrator if you do not know the name.  The limit for computer names on TOPS Terminal is 
16 characters.  

Note:  to move around in the dialog window, use the mouse or press the Tab key.  If the short 
version of the dialog window — without phone information — is displayed, the Tab key moves 
the cursor in this sequence:  Computer's Name, Its Location, TCP/IP Address, TCP/IP Timeout.

4. Type the computer's Location (optional).

This is an optional field and normally not important for network computers.  

5. Type the computer's TCP/IP address.

This is the network address of the computer.  If you have Kipper or another KIP server running on 
your network, you will not need to enter the TCP/IP address; the name of the computer will be 
sufficient.  When you press Return or click OK  after completing the rest of the description, the 
TCP/IP address will be entered automatically into the address box.
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6. Select the computer's operating system.

Select a different operating system, if appropriate.  Check with your system administrator if you 
are unsure.  

Here is an example of a completed computer description, for a computer called Suntops, located 
in Alameda, California, running UNIX, with a TCP/IP address of 131.131.5.3:

Note for VMS system administrators and users:  you must include the following 
command in your login.com file on the VMS system: set term/inquire  

7. Specify TCP/IP Timeout.

This tells TOPS Terminal how long, in seconds, to wait for a response from the other computer 
before terminating the connection; the default value is 300 seconds (five minutes).  This lack of 
response might occur because the computer is down or because there was a failure in the network.

8. Click OK to complete the description.

Now that you have given TOPS Terminal all the necessary information, click OK.  The name of 
the computer you have just described will appear on the list of known computers:

Note:  if your KIP server did not find a TCP/IP address for the computer you named, or if you 
did not enter a proper TCP/IP address, your Macintosh will beep when you click OK, telling you 
that the description must have a proper TCP/IP address.

9. Click Done.
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Or click on the close box; this step is not strictly necessary, since the computer description was 
stored in TOPS Terminal Memory when you clicked OK in step 8.  

You have completed the description of a computer for a network account.  Go to page 44 to see 
how to create an account description for the computer description you created.  

Phone Connection 

The procedure for creating a computer description for a phone connection is much like that for 
creating a computer description for a network connection, presented above; the first four steps 
below and steps 10, 11, and 12 are specifically for phone connection computers.  Skip this 
section if you do not plan to make phone connections.  
Note that TCP/IP address and timeout are not included below; if you include both a TCP/IP 
address and a phone number, TOPS Terminal will try to make a network connection.  
To create a computer description for a remote computer that you will connect to by phone, do the 
following after starting up TOPS Terminal:

1. Select Modem from Settings menu.  

2. Select a modem type.  

3. Change phone settings.  

Click on any of the three check boxes to change the settings, if necessary.  

Modem speaker on:  This can be very handy, if your modem is close enough so that you can 
hear it.  With the modem speaker on, you can hear when you get a wrong number or if the line is 
busy.  

Use pulse dialing:  If your phone uses pulse rather than tone dialing, check this box.  
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Dial 9 for outside line:  If you need to dial 9 to get an outside line on your phone, click on the 
bottom box; do not include the 9 in the phone number if you check this box.  

4. Click OK.

5. Select Computers from Settings menu.

The List of Known Computers will be displayed:

6. Click the New button.

A blank description of a computer will be displayed, in its long form, with phone and modem 
information included at the bottom: 
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7. Type the remote computer's name.

Check with your system administrator for this and all other requested information, if you are not 
sure.  In this example the computer is called TOPS BBS.  (The limit for computer names on 
TOPS Terminal is 16 characters.)  

8. Type the computer's location (optional).

This is an optional field, which is important for phone connections; you will want to have some 
idea of toll charges.  TOPS BBS is located in Alameda, California.  

9. Select the computer's operating system.

Select a different operating system, if appropriate.  Check with your system administrator if you 
are unsure.  TOPS BBS runs on Red Ryder Host.  
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10. Type the computer's phone number.

Include the area code, if it is not the same as your area code.  The number for TOPS BBS is (415) 
555-1212.  

11. Select the baud rate for the modem.

Click on the appropriate rate in the list (1200 in this example).  

12. Change communication settings, if necessary.

If any of the settings (Stop Bits, Attention signal, Parity, Handshake, Seven Data Bits, and Repeat) 
are not correctly set, correct them; see your system administrator if you are not sure about these 
settings.  Note that Repeat refers to the number of times to repeat the Attention signal.  

A completed computer description for the TOPS Bulletin Board System is shown on the opposite 
page:  
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13. Click OK.

The name of the computer description you have just created will appear on the list of known 
computers, in alphanumeric order: 

14. Click Done.

Or click on the close box; this step is not strictly necessary, since the computer description was 
stored in TOPS Terminal Memory when you clicked OK in step 13.  

You have completed the creation of a computer description for a phone-connection account.  See 
“Creating an Account Description” below to learn how to create an account description for the 
computer description you just created.  

Creating an Account Description

An account description includes all the information needed by TOPS 
Terminal to establish a connection with a remote computer:  the 
computer description, your user name, and the type of terminal you 
wish to emulate.  Optionally, you can also include your password on 
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the remote computer in the account description.  This section shows 
you how to create an account description; instructions for modifying 
or removing account descriptions follow on  68 and page 73, 
respectively.
Each account description is linked to a particular remote computer by 
including a computer description in the account description.  There 
are three ways to do this: 

•  Choose a computer description from TOPS Terminal Memory
    (Memory)
•  Choose a computer description from a sign-up file (Sign Up)
•  Create a new computer description as you create the account 
    description (New)

Each of these methods is explained separately below.  

Choose a Computer from TOPS Terminal Memory 

To create a new account description using a computer description from TOPS Terminal Memory, 
do the following after starting up TOPS Terminal:

1. Select Accounts from Settings menu.

The List of Known Accounts will be displayed; if you have not created any account descriptions, 
none will be listed.  
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2. Select New.  

This indicates that you want to create a new account description.  

When you select New, a dialog window will be displayed, giving you three methods (Memory, 
Sign Up, or New) for including a computer description as part of an account description:  

3. Click Memory.  

When you select Memory you are indicating that you want to select a computer description from 
the list of computer descriptions in your TOPS Terminal Memory.  

You will be asked to select a computer for the new account:
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4. Select a computer description and click OK.

Use the mouse or the arrow keys to select the computer description you want to use for this 
account description and click OK.  In this example we will use the computer Suntops (which was 
described earlier in this chapter).  You will be asked to enter your user name and a password (if 
any) on the computer.

5. Type your user name.

Your user name is the name or ID you use to log on to the computer.  This name (dave in the 
example below) is normally assigned by the system administrator of the computer you selected for 
this account.  Press the Tab key or Return to move the cursor to the password box.  

6. Type your password (optional).

Type your password if you want it included in the account description; if you don't enter it here, 
you will be asked for it when you try to connect to the remote computer automatically.  

Your password will not print on the screen, preventing anyone from reading it as you type it.  
Some computers you connect to will have no password security; ignore this step if that is the case. 
The completed user name and password dialog window looks like the following, if you enter a 
password:  
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Note:  Entering your password here does not set up a password on the other computer; this only 
tells TOPS Terminal what your password is on the computer; see "Commands Menu” in Chapter 4 
to see how to change your password on the other computer using TOPS Terminal.  See “Password 
Saved in TOPS Terminal Memory” on page 68 for a discussion of password security.  

7. Click OK.

If you included your password in step 6, you will be asked to type it a second time, to be sure you 
typed it correctly.  Type it again and click OK.

You will be asked what kind of terminal should be emulated:

If you see some strange-looking characters when you are logging on, the terminal type may be 
incorrect; try another type or see your system administrator.  

8. Select a terminal type and click OK.

The Description of an Account dialog will be displayed:
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9. Change settings and terminal type, if necessary.

Click on a terminal type and one or more of the check boxes, if you wish to change any of these 
settings.  See “Modifying an Account Description” on page 68 for discussions about selecting a 
different terminal type or changing the settings of the three check boxes.

10. Click OK.

You have completed the account description; the list of described accounts will be displayed again, 
with the new account description added to the list, in alphanumeric order.  

11. Click Done.

The new account description has been saved in TOPS Terminal Memory and is ready to be used to 
make an automatic connection.  See page 56 for a discussion of automatic connections.  

Choose a Computer from a Sign-Up File 

In the example above, the computer description used in creating an account description was 
taken from TOPS Terminal Memory.  The computer description can also be taken from a sign-up 
file provided by your system administrator.  Sign-up files are explained in detail in Appendix F.  
To create a new account description using a sign-up file, do the following after starting up TOPS 
Terminal:

1. Select Accounts from Settings menu.
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The List of Known Accounts will be displayed:

 

2. Select New.  

The Three Ways to Create an Account dialog will be displayed:

3. Click Sign Up.

You will be asked where the sign-up file is:  
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4. Select a sign-up file.

Select the sign-up file from the current folder or change folders to find the sign-up file.  Your 
system administrator, who provides sign-up files to users, will tell you where to find it.  A sign-up 
file can have any name.  

5. Click Open.

You will be asked to select a computer for the new account description:

This dialog has the same look as that displayed when you choose a computer description from 
your TOPS Terminal Memory, but the computer descriptions in the list are not the same; these 
computer descriptions are in a sign-up file and not in your TOPS Terminal Memory.

6. Select a computer description and click OK.

Select a computer description from the list of computer descriptions and click OK or double click 
on the computer description in the list (TOPS BBS in this example).  The user name and password 
dialog will be displayed.
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Note:  The computer description you select is added to the account description you are creating 
— plus it is added to the list of known computer descriptions in your TOPS Terminal Memory.  

From here on the instructions are the same as for creating an account description using a computer 
in TOPS Terminal Memory (see steps 5 to 11 starting on page 46 if you have any questions).  

7. Type your user name.

8. Type your password (optional).

9. Click OK.

If you included your password in step 8, type it a second time and click OK.

10. Select a terminal type and click OK.

11. Change settings and terminal type in the Description of an Account, if desired.

12. Click OK.

You have completed the account description.  The list of known accounts will be displayed again, 
with the new account description added to the list, in alphanumeric order:  

13. Click Done.

The new account description has been saved in TOPS Terminal Memory and is ready to be used to 
make an automatic connection.  See page 56 for a discussion of automatic connections.  

Create a New Computer Description 

To create a new computer description in the process of creating a new account description, do 
the following after starting up TOPS Terminal:  

1. Select Accounts from Settings menu.
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The List of Known Accounts will be displayed:

2. Click New in List of Known Accounts.  

The Three Ways to Create an Account dialog will be displayed:

3. Click New in Three Ways to create an account.  

You will be asked what name you would like to use for the computer.  

4. Type in a name and click OK.
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The user name and password dialog window will be displayed.

5. Type in your user name.

6. Type in your password (optional).

7. Click OK.

If you included your password in step 6, type it a second time and click OK.  You will be asked 
what kind of terminal to emulate.

8. Select a terminal type and click OK.

A blank Description of a Computer will be displayed, with the name you chose filled in:  

9. Complete the computer description and click OK.

Complete the computer description as explained in “Creating a Computer Description” on page 
35.  When you click OK after completing the computer description, the Description of an 
Account will be displayed:
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10. Change settings and terminal type in the Description of an Account, if desired.

See “Modifying an Account Description” on page 68 for discussions of the check boxes and 
terminal type.

11. Click OK.

You have completed the account description.  The list of known accounts will be displayed again, 
with the new account description added to the list, in alphanumeric order.  

12. Click Done.

The new account description will be saved in TOPS Terminal Memory, ready to be used to make 
an automatic connection.  See below for a discussion of automatic connections.  

Making an Automatic Connection

Once you have created computer and account descriptions, you will make automatic connections 
to remote computers for terminal emulation, file transfers, and remote editing.  There are two 
ways to make an automatic connection to a remote computer:  

•  Select File Session in the Network menu
•  Select Terminal Session in the Network menu
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Which of these you use depends on what function you want to perform (terminal emulation, file 
transfer, text editing) and whether you will be using a network or phone account.  See Chapter 1 
for a discussion of the differences between network and phone accounts, and the services 
available with each.  
Both ways of making an automatic connection to a remote computer are explained below; the 
process is very simple when you select File Session, which is explained first.  The process is 
more complicated when you select Terminal Session because session transcripts may or may not 
be saved during terminal sessions.

File Session

To make an automatic connection to a remote computer on your network for file transfers or 
remote editing, do the following after starting TOPS Terminal:

1. Select File Session in Network menu.

You will be asked to select the account you wish to use to make the automatic connection:

Note that phone accounts are not enabled — because file sessions are for network accounts only.  

2. Select an account and click Connect.

A new session window will be drawn and an FTP file session will be started up.  If you have not 
included the password in the account description, you will be asked for the password before the 
connection is completed.  A list of the commands available during a file session is the last item in 
the window.  
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Once the connection is made, the file transfer services of TOPS Terminal are available:  you can 
send or receive files (Chapter 5), perform remote editing (Chapter 6), or execute the commands 
listed in the file session window.  Note that these commands are invoked using the Network or 
Network/Commands menu; you can't type commands during a file session.  

Terminal Session - Introduction

Three variations for making an automatic connection with the Terminal Session command are 
presented below.  Once you have made the connection, there are a number of functions you can 
perform on the remote computer.  See Chapters 4, 5, and 6 for discussions and specific 
instructions about terminal emulation, file transfers, and text editing and printing, respectively.  
When you make an automatic connection to a remote computer, you may or may not want to 
save the transcript of the terminal session you are starting.  By default, session transcripts will be 
saved to a new file, automatically created by TOPS Terminal.  You have two other options, 
however:  you can tell TOPS Terminal not to save transcripts when you describe an account, or 
you can tell TOPS Terminal to append the transcript of this session to an existing file.  All three 
options are described separately below.
A note about disconnecting:  log off from the remote computer and close the terminal session 
window by clicking on the close box when you are finished.  

Terminal Session - Save Transcript 

Use one of the accounts you described earlier in this chapter to start a terminal session on a 
remote computer.  If you did not check Don't Save Session Transcripts in the account description, 
the transcript will be saved.  Do the following after starting up TOPS Terminal:

1. Select Terminal Session in the Network menu.

You will be asked to select an account to use to log on to the remote computer:  
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2. Select an account and click Connect.

You will be asked where you want to save the transcript:  

3. Name the file and click Save.

You can save the transcript to the automatically-generated file name ("Suntops 3/29/88 0” in the 
example above), or you can type in a new file name.  If you want the transcript saved in a different 
folder than the current one, select a folder from the list, click Save to open the folder, and click 
Save a second time.  

When you click Save or press Return, a new session window will be drawn and TOPS Terminal 
will make the connection to the remote computer and begin the login process.  If you have 
included the password in the account description, you will be logged on to the computer, ready to 
work; if that is the case, skip step 4 below.  

4. Type password (if necessary) and press Return.

If you did not include your password when you described the account, type it when it is requested 
in the session window and press Return.  You are logged on to the computer, ready to work.
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Once you have made a terminal session connection to a remote computer, there are three major 
functions you can perform:  terminal emulation (Chapter 4), file transfer (Chapter 5), or remote 
editing (Chapter 6).  

Terminal Session - Don't Save Transcript 

If you checked Don't Save Session Transcripts in an account description, connecting to a remote 
computer is a two or three-step process.  After starting up TOPS Terminal:

1. Select Terminal Session in the Network menu.

You will be asked to select an account to use to log on to the remote computer:
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2. Select the account to use and click Connect.

When you click Save or press Return, a new session window will be drawn and TOPS Terminal 
will make the connection to the remote computer and begin the login process.  If you have 
included the password in the account description, you will be logged on to the computer, ready to 
work; if that is the case, skip step 3 below.

3. Type password (if necessary) and press Return.

If you did not include your password when you described the account, type it when it is requested 
in the session window and press Return.  You are logged on to the computer, ready to work.

Once you have made a terminal session connection to a remote computer, there are three major 
functions you can perform:  terminal emulation (Chapter 4), file transfer (Chapter 5), or remote 
editing (Chapter 6).  
A note about saving the transcript:  you can save the transcript by selecting Save in the File 
menu before disconnecting from the remote computer.

Terminal Session - Append Transcript 

Whether or not you elected to save session transcripts in an account description, you can tell 
TOPS Terminal to append a transcript to the end of an existing file before you choose the account 
to use for the connection.  After starting up TOPS Terminal:
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1. Select Terminal Session in the Network menu.

You will be asked to select an account to use to log on to the remote computer:

2. Check Append the transcript to an existing file.

If you check Append  the transcript to an existing file, the transcript of the session will be 
added to the file you select in step 4 below.  This is a handy way to keep all transcripts for a given 
account in one place; use this for saving all transcripts from connections to a bulletin board 
system, for instance.  

3. Select the account to use and click Connect.

After you click Connect, you will be given the opportunity to select the file from the list of text 
files in the current folder, or to change folders and select a file.
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.  

4. Select a file and click Open.

If the file to which you wish to append the transcript is in a different folder than the current one, 
select the folder from the list, click Open to open the folder, select the file, and click Open a 
second time.  

After you have selected the file and clicked Open, a new session window will be drawn and 
TOPS Terminal will make the connection to the remote computer and begin the login process.  If 
you have included the password in the account description, you will be logged on to the computer, 
ready to work; if that is the case, skip step 5 below.

5. Type password (if necessary) and press Return.

If you did not include your password when you described the account, type it when it is requested 
in the session window and press Return.  You are logged on to the computer, ready to work.

The file you selected to append the transcript to will be opened and displayed, with the cursor 
sitting at the end of the file, waiting for you to issue commands on the remote computer.  

Note the scroll bar at the right of the window, which indicates that you can scroll back in the file.  
If you type anything after scrolling back, however, the window will automatically scroll to the end 
of the transcript, which is where the typed text appears.  
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Once you have made a terminal session connection to a remote computer, there are three major 
functions you can perform:  terminal emulation (Chapter 4), file transfer (Chapter 5), or remote 
editing (Chapter 6).  

Modifying a Computer Description 

To modify an existing computer description do the following after starting up TOPS Terminal:  
1. Select Computers from Settings menu.

The List of Known Computers will be displayed.
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2. Select the computer description to be modified and click Open:

The description of the selected computer will be displayed:

3. Modify the computer description.

You can modify anything but the name.  If you change the name, you will be creating a new 
computer description when you click OK.  Use this method for testing various settings.  

4. Click OK.

The List of Known Computers will be displayed.  Click on the close box, if you are finished with 
computer descriptions.
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Removing a Computer Description 

To remove an existing computer description:
1. Select Computers from Settings menu.

The List of Known Computers will be displayed.

2. Select the computer description you want to remove.

3. Click Remove.

If the computer description you are trying to remove is used in an account description, you will 
see the following:
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You will have to remove the account description before you will be able to remove the computer 
description.  See “Removing an Account Description” on page 73 below.

Modifying an Account Description

Once you have created an account description, you may want to modify the description.  You 
modify the description by displaying the Description of an Accountand clicking on one of the 
check boxes or selecting a different terminal type.  
The Description of an Account is displayed in two circumstances:  near the end of the process of 
creating a new account description and when you select an account from the List of Known 
Accounts  and click Open.

You may change four things in an account description:
•  Whether your password is saved in TOPS Terminal Memory
•  Whether session transcripts are saved
•  Whether lines that scroll off the top of a session window are 
    retained in memory during a terminal session 
•  What type of terminal to emulate during a terminal session

Each of these is discussed in detail below.

Password Saved in TOPS Terminal Memory

A password is part of the login process on many computers.  When you create a TOPS Terminal 
account description, you can include the password or not, as you wish.  If you enter a password, 
the Password Saved in TT Memory box will be checked when the Description of an Account is 
displayed; if you don't enter a password the box will be blank.
If you change your mind and want to change the password-saved setting, click on the Password 
Saved in TT Memory box and click OK.  
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If the box is not checked when you click on it, clicking on it will cause it to be checked; when you 
click OK you will be asked to type the password for the account, and then to type it a second 
time.  The password will be saved in TOPS Terminal Memory and you will not have to type it 
when you connect to the remote computer.  
If the box is checked when you click on it, clicking on it will uncheck it; the password for the 
account will no longer be stored in TOPS Terminal Memory.
Changing Your Password
The best way to change your password on a computer you connect to with TOPS Terminal is to 
select Password in the Network/Commands menu during a terminal session; the password will be 
changed on the remote computer and in TOPS Terminal Memory.  
If you change your password on a remote computer in any other way and if you have checked 
“Password Saved in TT Memory” in the Description of an Account, you will have to change it in 
TOPS Terminal separately.  After displaying the Description of an Account, do the following:  

1. Click on Password Saved in TT Memory.

This will 'uncheck' the box.

2. Click on Password Saved in TT Memory again.

You will be asked to type the password:
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3. Type password and click OK.

You will be asked to enter the password again.

4. Retype password and click OK.

The Description of an Account will be displayed; the new password has been added to the 
account description in TOPS Terminal Memory.

About Password Security:  
If you type in your password as part of an account description, the connection to the computer will 
be completely automatic, but there will be a security risk:  anyone who has access to your TOPS 
Terminal Memory file can discover your passwordand anyone who runs TOPS Terminal from your 
Macintosh can log on to the computer by selecting this account.    
The safest thing to do, if you are concerned about this breach of security, is to not include your 
password when you describe an account.  You will be asked for it whenever you use the account 
to connect to the computer.  Another way to get around this problem is to keep your TOPS 
Terminal Memory file on a floppy disk and to lock the disk away when you are not using it.  
Note:  entering your password as part of an account description has nothing to do with whether 
passwords are saved in RAM memory during a TOPS Terminal session.  This is a preference in 
Your Preferences, which is discussed in Appendix B.  

Don't Capture Lines Off Top

When you connect to a remote computer, you begin a terminal session.  TOPS Terminal 
maintains a transcript of each terminal session in memory on your Macintosh.  This allows you to 
scroll back in the session transcript:  if you want to see something that occurred earlier in the 
session, you can click in the scroll bar or scroll arrows at the right of the window and see what 
has scrolled off the top of the window.  
If you want to preserve memory for other activities, and if you are sure you won't need to scroll 
back during a terminal session, click on the Don't Capture Lines Off Top box:
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Subsequently, during any terminal session for this account, anything that scrolls off the top of 
window will be gone and will not be part of the transcript; the scroll bar at the right of the window 
will not be active.  
See “Clear Lines Off Top” and “Capture Lines Off Top” on pages 83 and 84 to see how to clear 
lines off the top of a transcript and how to change the Capture  Lines Off Top setting during a 
session.

Don't Save Session Transcripts

TOPS Terminal will save the transcript of a terminal session in a disk file, unless you specify that 
you don't want it saved.  You will often want to save transcripts, especially if you are calling a 
bulletin board system such as TOPS BBS or CompuServe.  Be aware, however, that saving many 
terminal session transcripts can use up a lot of disk space.  
If you don't want transcripts for an account saved to disk, click on the Don't Save Session 
Transcripts box:

(If you click in the box when it is checked, it will no longer be checked and session transcripts will 
be saved for the account.)  
Note:  even if you check Don't Save Session Transcripts for an account, you can still save the 
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transcript during a terminal session, as will be explained in Chapter 4.

Change the Terminal Type

TOPS Terminal gives you the choice of five types of terminals to choose from during account 
descriptions.  You can change the terminal type in the Description of an Account dialog:

If you are getting strange results when you log on to a remote computer from TOPS Terminal, you 
might try a different terminal type to see if that is the problem.  Use the mouse or the arrow keys 
to select a different terminal.

Removing an Account Description

To remove an account description from the List of Known Accounts, 
do the following after starting up TOPS Terminal:

1. Select Accounts from the Settings menu.

2. Select the account description to remove.  
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3. Click Remove.  

The selected account description will be removed from the List of Known Accounts.

Chapter

4
Terminal Emulation

Once you have created computer and 
account descriptions, you can connect 
to a remote computer automatically and 
take advantage of all of TOPS 
Terminal's services:  terminal emulation, 
file transfer, and remote editing.  
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This chapter describes terminal 
emulation functions you can perform 
from your Macintosh, including:

•  Using the Network/Commands menu
•  Using the Network/Controls menu
•  Using Power-key equivalents for menu and dialog functions
•  Sending a text file to a program on a remote computer
•  Interrupting a script or file transfer command
•  Executing the Reset Terminal command
•  Killing the connection to a remote computer
•  Executing a macro on a remote computer
•  Editing during a terminal session
•  Saving a session transcript to disk
•  Disconnecting from a remote computer

Terminal Services on a Remote Computer 

When you make an automatic connection to a remote computer, 
TOPS Terminal helps you perform a number of functions on that 
computer, including executing commands and issuing control-key 
sequences from the Network menu.  These terminal services make 
work on the remote computer easy for you, if you are not familiar with 
that computer's operating system.  

Commands Menu

The Commands menu lets you execute certain commands on a 
remote computer even if you don't know the command structure on 
that computer.  Once you are logged on to a computer with TOPS 
Terminal, you can execute commands by typing them and pressing 
Return or Enter.  But suppose you don't remember the command 
names.  If you select Commands under the Network menu, the 
available commands will be listed:  

newpath
72 144 moveto 0 9 rlineto 0 -9 rmoveto 9 0 rlineto
72 756 moveto 0 -9 rlineto 0 9 rmoveto 9 0 rlineto
468 144 moveto 0 9 rlineto 0 -9 rmoveto -9 0 rlineto
468  756 moveto 0 -9 rlineto 0 9 rmoveto -9 0 rlineto
stroke



Do the following to select one of the listed commands:
1. Select Commands menu.

Click and hold on the Network menu, moving the mouse down until the Commands menu is 
displayed.  

2. Select the command to execute.

While continuing to depress the mouse button, move the mouse to the right and move it up or 
down in the Commands menu until the command you want to execute is highlighted; release the 
mouse button to execute the command.  

3. Type in the dialog windows.

Type the requested file name, directory name, or password in the dialog windows (displayed 
below, as each command is described).  

The period that you see in the dialog window for some of the commands represents the current 
directory (your login directory is the default) on a UNIX system.  You can list a different directory 
by including the full path name for the directory you want to list.  

4. Click OK.

For all but Goodbye, click on the OK button. 

After you click OK the command will be displayed in the session window and will be executed as 
if you had typed the command and pressed Return.

Note:  these commands can also be issued by using the “power key” equivalents, which are listed 
to the right of the function in the Commands menu.  See “Power Keys” later in this chapter for 
details.

Here are the commands in the Commands menu, with their UNIX equivalents in parentheses:
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List Files (UNIX = ls) 
Lists the files in the selected directory on the remote computer.  

If you were logged on to a VMS system, the List Files command would execute the VMS 
command DIRECTORY.

Delete File (UNIX = rm)   
Deletes the selected file on the remote computer.  Include the path name if the file is not in the 
current directory.  Depending on your profile on the remote computer, you may have to respond Y 
or N to delete the file selected.

Copy File (UNIX = cp)  
Makes a copy of a file on the remote computer.  Type the name of the existing file, press the Tab 
key to move to the other box, type the name you want for the copied file, and click OK.

Move File (UNIX = mv)  
Moves a file from one directory to another, or gives a file a new name on the remote computer.  
Type the name of the existing file, press the Tab key to move to the other box, type the new name 
for the file, and click OK..
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Go To (UNIX = cd)  
Changes the current directory.  Type the name of the directory you want to change to, including 
the path name, if necessary.

File Info (UNIX = ls -l)  
This gives you a more complete listing than ls, by displaying file ownership information, file 
modification dates, and file sizes.  Include the path name if you want to list something other than 
the current directory.

Type File (UNIX = cat)  
Lists the contents of the designated text file on the screen.

Password (UNIX = passwd)  
Allows you to change your password on the remote computer.  If you have included your 
password as part of the account description on TOPS Terminal, this password will be changed, 
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also.  You will be asked to type the password a second time to be sure you typed it as you 
intended.

Note:  Use this method to change your password rather than changing it on the remote computer 
directly; if you change it on the remote computer, you will have to change it on TOPS Terminal, 
also, or automatic connections will not work.

Goodbye (UNIX = logout)  
Logs you off from the remote computer immediately.  The connection to the remote computer is 
terminated and the session transcript becomes an editor document.

Controls Menu

Many of the operating systems to which you will connect using TOPS Terminal require you to 
send certain control-key sequences in order to perform various functions.  For example, on a 
UNIX system you can issue an interrupt to the current program with Control-C (hold down the 
control key and press the ‘c’ key).  
TOPS Terminal frees you from having to remember some of the most important of the control 
characters by including a Controls menu.  If you select Controls under the Network menu, you will 
see the available selections:

If Your Keyboard Has No Control or Escape Key

Some Macintosh computers that run TOPS Terminal do not have a Control key or an Escape 
(esc) key.  In that case, use the Network/Controls menu to execute the control-key sequences 
available there, as described above.  If you want to execute other Control-key functions or if you 
need an Escape key, TOPS Terminal lets you simulate Control and Escape key sequences during 
terminal emulation sessions, as follows:  

•  ⌘-Shift for Control
•  ⌘-` (Clover-backquote) for Escape

If you wish, you can change the key combinations by selecting Your Preferences in the Settings 
menu, as explained in Appendix B.
Do the following to select one of the menu choices:

1. Select Controls menu.

Click and hold on the Network menu, moving the mouse down until the Controls menu is 
displayed.  
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2. Select function to perform.

While continuing to depress the mouse button, move the mouse to the right and move it up or 
down in the Controls menu until the function you want to perform is highlighted; release the 
mouse button to execute the function.  

Note:  These control-key sequences can also be issued by using the “power key” equivalents, 
which are listed to the right of the function in the Controls menu.  See “Power Keys” later in this 
chapter for details.

When you select one of the control functions, TOPS Terminal sends the appropriate control 
sequence to the remote computer.  For example, selecting End of File will send the end-of-file 
character (CTRL-D on a UNIX system) to the remote computer.  The other Control characters 
(and their UNIX equivalents):
Flush Output (UNIX = CTRL-O)  
Terminates listing of output.  Use this when you have issued a command which is generating a 
long output stream which you are not interested in.

Zap Program (UNIX = CTRL-\)  
More serious interrupt than the Interrupt command in the Networks menu.  Tries harder (and with 
less finesse) to stop the current program or function.

Erase Word (UNIX = CTRL-W)  
Erases the last word typed on the command line.

Erase Line (UNIX = CTRL-U)  
Erases the text on the command line, back to the prompt.

Literal (UNIX = \)  
Interprets character literally.  Use this to tell the computer's operating system that you do not want 
the next character you type to be interpreted as a control character, but rather as a character 
only.

Send Break (UNIX = CTRL-C)  
Sends the break character for the operating system.  The result depends on the context; for a 
phone connection, a break may hang up the phone or change the baud rate on remote 
computer's modem.  For a network (TCP/IP) connction, it may act as an Interrupt.
Note:  most of the control functions (zap, end of file, erase word, literal) do not work with manual 
connections; your Macintosh will just beep when you select one of these.

Send Text

The Network menu command Send Text allows you to include the contents of a text file in the 
data flow of a program on a remote computer; the file is sent as if you are typing it from the 
keyboard.  Before selecting Send Text you must give some command on the remote computer 
that will accept the contents of the file.  You could, for instance, start up a text editor, go into insert 
mode, select Send Text from the Network menu to insert the contents of the file into the edit 
document.  
Or you could start up a mail program on the remote computer, and once you have designated to 
whom the mail is to be sent, include the contents of a file as the message:

mail tim [Return]
Subject:  [type message subject]  [Return]
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Select Network/Send Text
Select a file from the list of files
Click OK (the text in the file will be inserted into the message)
Type more text, if you wish
Select End of File from Commands menu to send message

Note:  Send Text uses no protocol, so on phone connections it is possible that a file sent this way 
will be corrupted by line noise.  If possible, XMODEM should be used for file transfers over phone 
lines; where it is impossible or highly inconvenient to do so, use Send Text.
Also, Send Text will not send files longer than 16 kilobytes, because of the danger of flooding the 
other computer's typing reception buffers.  Send Text is meant for short files, particularly bulletin 
board and mail messages.  Use Send File (which use FTP or XMODEM) for longer files; see 
Chapter 5 for a description of Send File.

Interrupt

The Interrupt command in the Network menu terminates whatever function is currently executing 
on a session.  If the session is transferring a file, the transfer is aborted.  If the session is running 
a program, an interrupt signal is sent to that program, which may handle it in a variety of ways, 
but usually will simply die.  If the session is running a script or macro, that script or macro will be 
terminated.  

Clear Lines Off Top

You can determine what part of what appears in a session window is stored in memory (and is 
thus included in the transcript) by using Clear Lines Off Top and Capture  Lines Off Top  in the 
Network menu.  
Select Clear Lines Off Top to discard everything above the last screen in the session transcript.  
Use this feature to discard unneeded startup text at the beginning of the connection dialog, or any 
text that you do not want saved in the session transcript.  
To clear the transcript of all lines above the last window in the transcript, do the following during a 
terminal session: 

1. Click and hold on the Network menu.

2. Select Clear Lines Off Top.
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3. Release the mouse button.

Everything above the last window in the transcript will be discarded, even if you have scrolled to a 
previous window in the transcript.

Capture Lines Off Top

When there is a check mark next to Capture  Lines Off Top, everything that happens in the 
session window is being stored in memory; you can scroll back above the current screen during a 
session.  
Capture  Lines Off Top is a toggle selection, meaning that if you select it when it is on, it will be 
turned off; if you select it when it is off, it will be turned on.  For example, if it is checked, click on 
Capture  Lines Off Top to stop saving to the session transcript from the current screen on.  

Note that you have to release the mouse button to change the setting, then select the Network 
menu again to see that the change was made.

Reset Terminal (full menu only)

Reset Terminal recovers from certain kinds of errors during a terminal session.  During a phone 
session, for instance, “line noise” might make TOPS Terminal think it should change into some 
other mode, thus making the session window difficult to read.  Selecting Reset Terminal may 
solve this problem.  Note, however, that if you select Reset Terminal you will be warned that this 
might cause problems, especially if you are running a graphics program, and you will be given a 
chance to change your mind.  
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Kill Connection (full menu only)

Normally you will log off and click on the close box to end a session.  If this does not work, you 
may have to use the Kill Connection command in the Network menu.  Kill Connection is meant 
only for recovering from serious errors, such as when the other computer refuses to respond to 
you.  Killing a session in this way may have undesirable side effects, such as leaving files locked 
on the other computer or incurring connect charges on a commercial, modem-based computer.  

Macros (full menu only)

Use the Macros selection in the full Network menu to execute a macro you have written.  You can 
use macros to save the trouble of typing repeatedly-used sequences of commands.  A macro can 
be as small as sending a single command or as elaborate as reading and saving all your new 
mail.  See Appendix D for a full explanation of macros.  
There are two ways to execute a macro once you have selected Macros in the Network menu:  
move the pointer to the macro you want to execute and release the mouse button, or select Pick 
Macro — which will display a two-column list of the macros — and select OK.  
You can also execute a macro from the keyboard with the “power-key” combination, ⌘-; (Clover-
semicolon).  (Power keys are discussed in the section following this one.)  A two-column list of the macros 
available will be displayed, as when you select Pick Macro.  Select a macro with the mouse or type the first 
letter of a macro name to select it, and execute the macro by clicking on the OK button or pressing Return.  
(If two macros start with the same letter, type the first two or three letters of a macro name in rapid 
succession to select the one you want.)  

Power Keys

Like most Macintosh applications, TOPS Terminal provides a number of “power-key” shortcuts that you can 
use to minimize switching between the keyboard and the mouse to perform operations.  This capability is 
especially important in a terminal emulation program, since your work with the remote computer will largely 
consist of typed command lines.  
Some of the power-key functions were explained in “Dialog Window Conventions” in Chapter 1:  using the 
keyboard or the mouse, double clicking, selecting from a list, and making multiple choices in a list.  
Executing a macro from the keyboard was discussed above; other functions are described below.  

Mac Shortcuts for Menu Selection

Most TOPS Terminal menu commands have keyboard shortcuts, which are displayed next to the menu item 
when a menu is displayed.  Instead of pulling down a menu and selecting an item, you can type the 
keyboard equivalent, which usually entails holding down the  key (next to the space bar — sometimes ⌘
called the Clover or Command key) and pressing a single letter or punctuation mark.  For example, you can 
display the macros available to you by typing  ⌘ - ;  (Clover-semicolon).  Here are a few other useful 
keyboard menu shortcuts:  

 ⌘ - /  TOPS Terminal Help
 ⌘ - s  Save file 
 ⌘ - o  Open file 
 ⌘ - t  Start a terminal session 

⌘ - e  Edit a file on a remote computer
⌘ - q  Quit TOPS Terminal

There are many more menu selection shortcuts; for a complete list, see “Menus and Keyboard Equivalents” 
in Appendix A.  

Button Press Equivalents

As explained in Chapter 1, the default button (the one that is heavily outlined) in a dialog window can be 
selected by pressing Return or Enter.  If a Cancel button is displayed, it can be selected by using the ⌘-. 
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(Clover-period) combination, unless the Cancel button is thickly-outlined, in which case Return or Enter 
selects it.  
If a Help button is present, it can be selected by typing  ⌘ - Shift-H.  
Finally, any other button which is presented to you may be selected by pressing the   and Shift keys and ⌘
then typing the first letter of the button name.  For instance, you can select a button labeled Sign Up by 
giving the power key combination ⌘ - Shift-S.  

Editing During a Terminal Session 

You can use the File, Edit, and Text menus for limited editing during a terminal session.  See Chapter 6 for 
detailed descriptions of TOPS Terminal editor functions, which you can use on a session transcript after you 
have logged off from the computer and the transcript has become an editor document, as described below.  

Copy and Paste to a Text File

Since TOPS Terminal uses standard Macintosh windows and commands, you can select text in a session 
window and copy it to the Clipboard with the Copy command in the Edit menu.  If you want to save the 
selected portion to a text file while you are in TOPS Terminal, open a file with the New or Open command in 
the File menu and Paste the selected text in the file.  Alternatively, you can select a section of text and use 
Save Selection from the File menu.  
You can select the entire session transcript by selecting Select All in the Edit menu, select Open or New in 
the File menu to open a file, and select Paste to copy the transcript's contents to the file.  
You can use the scroll bar to scroll up and down in the session transcript.  And finally, you can use the Find 
functions in the Text menu to find selected or typed text anywhere in the session transcript.  
You cannot cut, clear, or replace any text during a terminal session; these functions are reserved for editing 
sessions, which are described in Chapter 6.  

When a Transcript Becomes an Editor Document

When a terminal session ends — that is, if you log off from the remote computer or the connection fails — 
the session transcript becomes a TOPS Terminal editor document.  You can tell when a session transcript 
becomes an editor document by observing the status box at the lower left of the window; it will change from 
“Connected to [computer name]” to “Editor Document.”  You can use all the editing features described in 
Chapter 6.  
You will have to re-establish the connection to the remote computer if you want to continue working on the 
computer.  

Saving a Session Transcript to Disk 

When you describe an account for connecting to a remote computer, you tell TOPS Terminal whether or not 
you want to save a transcript each time you connect to the computer.  And when you make a connection to 
the computer you decide where the transcript will be saved.  
Note, however, that during the terminal session you can modify what is included in the transcript by clicking 
on Clear Lines Off Top and Capture  Lines Off Top in the Network menu (see discussions of these items 
starting on page 83 above.  And regardless of what you tell TOPS Terminal in the account description, the 
transcript is not saved to disk until you explicitly tell TOPS Terminal to save it.  
A session transcript will be stored in memory unless you tell TOPS Terminal otherwise, but it is not saved to 
disk until you explicitly tell TOPS Terminal to save it.  There are three times when you can tell TOPS 
Terminal to save a transcript of a terminal session to disk:

• During a terminal session
• After logging off from a remote computer
• When closing or quitting
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Saving a Transcript During a Terminal Session
Select Save in the File menu to save a session transcript while you are still logged on to the 
remote computer (with “Connected to [computer name]” displayed in the status box of the session 
window).  The transcript will be saved in a file with the name displayed at the top of the session 
window.  
Saving a Transcript After Logging Off
When you log off from a remote computer, the session window remains in place, but the status 
changes from “Connected to [computer name]” to “Editor Document.”  You can now edit the 
document however you like, as described in Chapter 6.  
You can save the document by selecting Save or Save As in the File menu.  If you select Save, 
the document will be saved in a file with the name displayed at the top of the session window.  If 
you select Save As, you can save the document under any file name you choose.
Saving a Transcript When Closing or Quitting
If you click on the close box in a session window or if you select Quit in the File menu during a 
terminal session, you will get the opportunity to save the session transcript to disk — if the 
transcript has been designated to be saved.  The only time you would not be able to save the 
transcript would be if you have checked Don't Save Session Transcripts in the account 
description.  
See “Disconnecting” below for more about this method of terminating a session, which is not 
recommended.  Normally, you should log off before closing or quitting.

Disconnecting

When you are finished working on a remote computer you will want to 
terminate the connection; this is especially important for phone 
connections.  The normal procedure is to log off first and then close 
the TOPS Terminal connection.  There may be times when this 
method does not work, in which case you will have to kill the 
connection less gracefully.  See “Kill Connection” on page 85 to see 
what to do if you can't disconnect in the two ways described below.

Log Off and Close Connection

1. Log off.

Use the normal logoff procedure for the computer you are connected to (type logout or exit, for 
example).  You could instead pull down Commands in the Network menu and select Goodbye, 
as explained earlier in this chapter.

The session window will remain, but it will become an editor document:  the status area at the 
bottom left will reflect this change.

2. Edit the transcript, if you wish.

If you were planning to save the transcript of this computer session, you may want to make some 
changes to it before you close it.  You can edit the transcript like any other TOPS Terminal editor 
document, as explained in Chapter 6.
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3. Save the transcript, if you wish.

If you want to save the transcript, select Save in the File menu before clicking the close box in 
step 4 below.  

4. Click the close box at upper left of window.

If you have saved just before clicking on the close box or if the transcript is not being saved, the 
session window will disappear and whatever was displayed before you opened the session will be 
visible.  Ignore the following step, if that is the case.

If the transcript is being saved, and you have not just saved, you will be warned:

5. Click Yes or No.

Click Yes if you want to save the changes, No if you don't want to save the changes since the last 
save (which might have been when the session started).

The session window will disappear and whatever was displayed before you opened the session 
will be visible.

Close Connection without Logging Off

If you click on the close box without logging off, which is not recommended, you will be asked if 
you really want to close the connection:

Click Yes or No.
If the transcript was being saved, you will be asked if you want to save the changes:
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Click Yes, No, or Cancel.
The session window will disappear and whatever was displayed before you opened the session 
will be visible.

Chapter

5
File Transfers

TOPS Terminal makes copying (or 
“transferring”) files to and from your 
Macintosh easy.  As noted in Chapter 1, 
file transfers are accomplished 
differently for network and phone 
connections.  For file transfers with local 
area network accounts, you connect to 
the remote computer with the File 
Session command, which invokes TOPS 
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Terminal's file transfer service (FTP), 
and then select Send File or Receive 
File to copy the file.  
For file transfers with phone accounts, 
you connect to the remote computer 
with the Terminal Session command, 
since file transfer service is not available 
for phone accounts.  Once you have 
established a terminal session on the 
remote computer, you start the file 
transfer function appropriate for the 
remote computer and then use Send 
File or Receive File in the Network 
menu to copy the file.  
If you try to do a network account file 
transfer with a terminal session window 
active, you will see the following 
message:  
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File transfers for network and phone 
accounts are described separately 
below, after discussions of file transfer 
formats and file naming conventions.    
File Transfer Formats

Most operating systems have two main 
file types — plain text and one-part 
binary.  Macintosh files, however, are 
more like two-part binary, since two 
separate “forks” (resource fork and data 
fork) make up a Macintosh file.  
Because of this difference, it can be a 
little more complicated to transfer 
Macintosh files to other computers 
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(unless they are text files).  
The two primary formats for file transfer 
with TOPS Terminal are Text and 
MacBinary; in special cases you may 
want to use data or resource formats, 
which are the two separate elements of 
Macintosh files.  
Note that you do not always have a 
choice of what format to use when 
transferring files.  Depending on which 
file you select, some formats are not 
enabled when you use Send File, and 
only Text format is enabled when you 
use Edit File (see Chapter 6, “Text 
Editing and Printing”).

Text Format
Use Text format to transfer plain text 
documents.  Plain text documents 
include those created by TOPS 
Terminal’s text editor and by other 
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Macintosh applications such as MPW 
and MacTerminal.  
Also included are MacWrite and 
Microsoft Word documents saved in 
“text only” mode, and the output of text 
editors on most other computers.  Text 
transfers automatically convert to and 
from the text conventions of the 
operating system on the remote 
computer.  

MacBinary Format
MacBinary is a format which combines 
the two separate forks of a Macintosh 
file with some additional header 
information.  Use MacBinary format to 
transfer Macintosh applications and 
documents from graphic programs such 
as MacPaint, MacWrite, MacProject, 
and MacDraw.  Also use MacBinary to 
copy word processing files that include 
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formatting commands; examples are 
MacWrite and Microsoft Word 
documents that were not saved as “text 
only.”
Note:  You cannot change the name of 
a MacBinary file when you copy it from a 
remote computer with Receive File; the 
name of the file is included in the file 
itself, so changing the name externally 
does not affect the name.  If you want to 
change the name, copy the file to your 
Macintosh and then change the name.  

Data and Resource Formats
For some applications it may be useful 
to copy only one of the forks of a 
Macintosh file to a remote computer.  
The remaining two file transfer formats, 
data and resource, transfer the data fork 
and the resource fork, respectively.  
Data is the appropriate format for all 
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non-text files that are not MacBinary 
format.  Suppose, for example, that you 
want to copy a public-domain UNIX 
executable program file to your 
Macintosh.  Use data format; you will 
not be able to run the program on your 
Macintosh, but you can later copy the 
program from your Macintosh to another 
compatible UNIX computer and run it 
there.  

File Naming Conventions

Restrictions and guidelines for file 
names vary widely from one operating 
system to another.  If all the computers 
on your network and all the computers 
that you were to connect to over phone 
lines were to use the same operating 
system, file naming conventions would 
not be a problem.  The best solution to 
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problems caused by file naming 
differences is to give files names that 
work on all systems; this will make file 
transfers much simpler.
The table below presents naming 
conventions for Macintosh, UNIX, and 
VMS names.  Although you can rename 
files when you transfer them from one 
operating system to another, it is easier 
to choose file names that don't have to 
be changed during transfer between 
computers.  
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Macintosh Name UNIX Name VMS 
Name

• Up to 31 characters • Up to 256 
characters • Up to 39 
characters,

   followed by period 
• Blank spaces OK • Blank spaces OK 

• No blank spaces
• Can't use colon • Can't use slash (/); 

• Can't use most 
   avoid $, *,  ?, !, #,   special 

chars;
   brackets, parentheses,   

hyphen OK;
   single or double   semicolon 

for
   quotation marks.   version #.

In general, any VMS name shorter than 
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32 characters, and any UNIX name 
shorter than 32 characters and not 
containing a colon, is acceptable to the 
Macintosh.  Similarly, any Macintosh file 
name is acceptable to a UNIX system 
unless it has a slash (/) or other special 
characters listed above in it.  If you 
follow VMS limitations for all file names, 
you will probably have no problems with 
the Macintosh or UNIX systems as long 
as you don't exceed 31 characters and 
don't use a slash in a name.  Note 
especially that most special characters 
are not allowed in VMS names; hyphens 
are OK.
Note for UNIX users:  When TOPS 
Terminal creates an automatic file name 
for session transcripts, the name has 
slashes in it.  Be aware of this if you are 
sending such files to a UNIX system; 
you will have to rename the files as you 
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send them.  Also note that if you send a 
file with a name that includes a blank 
from your Macintosh to a UNIX system, 
you will have to quote the file name to 
access it on the UNIX computer; that is, 
you will have to put quotation marks or 
some other special character around the 
name.  For example, to copy a file 
whose name has blanks in it:  

cp “file with blanks” newname

File Transfer - Network Account

File transfers with network accounts use 
File Transfer Protocol (FTP), which is 
built onto TCP/IP protocols.  Network file 
transfers are performed during file 
sessions.

Send File - Network Account
To copy a file from your Macintosh to a 
remote computer with a network 
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account, start a File Session to connect 
to the computer and select Send File to 
start the transfer process.  
Do the following after starting TOPS 
Terminal:

1. Select File Session in the 
Network menu.

You will be asked to select an account.  Note that only network accounts are active:

2. Select account and click Connect.

A new session window will be drawn and an FTP file session will be started up.  If you have not 
included the password in the account description, you will be asked for the password before the 
connection is completed.  A list of the commands available during a file session is the last item in 
the window.  

Note that these commands are invoked using the Network or Network/Commands menu; you 
can't type commands during a file session.  
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3. Select Send File in the Network menu.

You will be asked to select the file you wish to send, the transfer format, and the name you want 
the file to have on the remote computer:

 

4. Select file to send.

If you do not see the name of the file you want to send, you may have to look into one of the other 
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folders or drives.  

Note that the name of the file you select is automatically entered into the box for the name the file 
will have on the remote computer; TOPS Terminal assumes that you will want the file to have the 
same name on the remote computer that it has on your Macintosh.  If you want to give the file a 
different name on the remote computer, see step 6 below.

Note also that the selected and available Transfer Format options change as different types of 
files are selected; the file selected above is considered to be a Text file and can only be sent as 
Text, MacBinary, or Data.  

5. Select Transfer Format.

Normally you will use whatever transfer format is selected by TOPS Terminal — Text in this 
example — but you may want to select another format in some cases.  See the discussion of file 
transfer formats at the beginning of this chapter.

6. Type name for file on the remote computer.

If you want to change the name the file will have on the remote computer, use the mouse to select 
the name box at the bottom of the dialog window and type in a new name.  In this case, we 
changed the slashes in the date to hyphens, since Suntops is a UNIX system and UNIX file names 
cannot contain slashes:

7. Click Send.
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Once you click Send the selected file will be copied from your Macintosh to the other computer.

Details about the transfer will be displayed in the file session window.  The text represents FTP 
commands (from your Macintosh) and FTP replies (from the other computer).  The replies, which 
begin with a three-digit number, may give you helpful information if errors arise.

The main thing you want to check is the end of the transcript, where you hope to see “Transfer 
complete” (or a similar message).  If the transfer fails, you will either see some indication of why 
it failed, or you will know it has failed because of the missing “Transfer complete” message.

Monitor the progress of the file transfer by watching the number of bytes increment in the status 
box at the lower left of the file transfer window.

Cancel a file transfer by selecting Interrupt under the Network menu or its keyboard equivalent, 
⌘-. (Clover-period).

Copy other files from your Macintosh to the remote computer by repeating steps 3 to 7 above.

8. Save session transcript (optional).

Select Save in the File menu if you want to save the transcript.  It will be saved in the current 
folder (unless you have checked Don't Save Session Transcript for the account, in which case it 
will be saved in the folder designated as the folder for temporary session transcripts in Your 
Preferences; see Appendix B for details).  

9. Select Goodbye from the Commands menu.

This is equivalent to logging off from a terminal session; since you can't type during file sessions, 
you have to use menus.  Alternatively, you could hold down the Option and Clover ( ) ⌘ keys and 
press the letter Y, which is the keyboard equivalent for Goodbye.   

The connection to the remote computer will be terminated and the file session transcript will 
become an editor document.

10. Click the close box.

The window will be closed and the window that was active when you started the transfer process 
will be the active window again.

Note:  if you click on the close box without selecting Goodbye, you will be asked if you are sure 
you want to close the connection to the remote computer.  This may leave a process running on the 
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remote computer; you should only bypass Goodbye if something is seriously wrong with the 
session.  

Receive File - Network Account

To copy a file from a remote computer to your Macintosh with a network account, start a File 
Session to connect to the computer and select the Receive File command.  
Do the following after starting TOPS Terminal:

1. Select File Session in the Network menu.

You will be asked to select an account.  Note that only network accounts are active:

2. Select account and click Connect.

A new session window will be drawn and an FTP file session will be started up.  If you have not 
included the password in the account description, you will be asked for the password before the 
connection is completed.  A list of the commands available during a file session is the last item in 
the window.  

Note that these commands are invoked using the Network or Network/Commands menu; you 
can't type commands during a file session.  
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3. Select Receive File in Network menu.

A dialog window will be displayed, asking you to select the file you want to copy from a list of 
files on the remote computer.  There may be a slight delay while TOPS Terminal prepares to list 
the current directory contents.  

4. Change directories, if necessary.

The two rows under the Go To Parent box list the files and directories in the current directory on 
the remote computer (Suntops, a UNIX system, in this case).  Use the scroll bar to scroll up or 
down to find the directory you want.
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To list the contents of a directory in the list, double click on it; a new list will be displayed.  To 
move up one level in the directory structure, click on Go To Parent.

Note to UNIX users:  directories and files look the same in the list.  If you think one of the 
entries is a directory, but you're not sure, double-click on the name; if it is a directory, the list of 
files in the directory will be listed.  

5. Select the file you want to copy.

When you are in the right directory, select the file you want to copy.  Note that the name of the file 
is automatically inserted into the Name box on the right side of the dialog window.

6. Change folders and the file name (optional).

Double-click on a different folder from the list on the right side of the dialog window, if you want 
the file copied to a folder other than the current one (“tops” in the example above and below).  
Note that only folders are 'active' in the list.  If you want the file to have a different name on your 
Macintosh, change or replace the name in the Name box.

Note about copying MacBinary files:  You cannot change the name of a MacBinary file as 
you copy it from a remote computer with Receive File; the name of the file is included in the file 
itself, so changing the name externally does not affect the name.  If you want to change the name, 
copy the file to your Macintosh and then change the name.  

7. Select Transfer Format.

Select one of the transfer formats (Text or MacBinary, probably), depending on what kind of file is 
being copied.  See the discussion of transfer formats at the beginning of this chapter.  Until you 
select a transfer format, the Receive button will not be enabled and you will not be able to copy a 
file.

8. Click Receive.

Once you click Receive the selected file will be copied from the remote computer to your 
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Macintosh.

If you see the message “Not a plain file” in the file session window after you click Receive, the 
transfer format is wrong or you have selected a directory instead of a file.

Details about the transfer will be displayed in the window.  The main thing you want to check for, 
as explained in the discussion of Send File - Network Account, is the message “Transfer 
Complete” (or a similar message).

Monitor the progress of the file transfer by watching the number of bytes increment in the status 
box at the lower left of the file transfer window:

Cancel a file transfer by selecting Interrupt under the Network menu or its keyboard equivalent, 
⌘-. (Clover-period).

Copy other files from the remote computer to your Macintosh by repeating steps 3 to 8 above.

9. Save session transcript (optional).

Select Save in the File menu if you want to save the transcript.  It will be saved in the current 
folder.

10. Select Goodbye from the Commands menu.

This is equivalent to logging off from a terminal session; since you can't type during file sessions, 
you have to use menus.  Alternatively, you could hold down the Option and Clover ( ) ⌘ keys and 
press the letter Y, which is the keyboard equivalent for Goodbye.   

The connection to the remote computer will be terminated and the file session transcript will 
become an editor document.

11. Click the close box.

The window will be closed and the window that was active when you started the transfer process 
will be the active window again.

Note:  if you click on the close box without selecting Goodbye, you will be asked if you are sure 
you want to close the connection to the remote computer.  This may leave a process running on the 
remote computer; you should only bypass Goodbye if something is seriously wrong with the 
session.  
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File Transfer - Phone Account

File transfer with phone accounts is similar to the process for network accounts, except that you 
use a terminal session instead of a file session, since file transfer service is not available for 
phone accounts.  For this reason, you must prepare for the transfer on the remote computer (step 
3 below) before starting the transfer.  

Send File - Phone Account

To copy a file from your Macintosh to a remote computer with a phone account, use Terminal 
Session to connect to the computer, prepare for the transfer on the remote computer, and select 
Send File to start the transfer process.  
Many of the steps in the process are the same as for copying a file with a network account; 
common steps are not explained below.  See “Send File - Network Account,” starting on page 96 
for details about those steps.  The main difference for phone accounts is that you have to prepare 
for the transfer process on the remote computer (step 3 below) before selecting Send File.
Do the following after starting TOPS Terminal:

1. Select Terminal Session in the Network menu.

You will be asked to select an account.  Both phone and network accounts are active (unless you 
haven't selected a modem type):  

2. Select account and click Connect.

A normal terminal session will be started up; you will next be asked where to save the session 
transcript, unless you checked Don't Save Session Transcript in the description of the account.  
You will be asked for your password if you did not include it in the account description.

3. Prepare for the transfer on the remote computer.

Prepare for the transfer process by starting the appropriate “download” process, which varies with 
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different operating systems (downloading is the act of copying a file from a remote computer to a 
local computer; when you send a file from your Macintosh to a remote computer, the remote 
computer regards it is a download).  

(This download process must be started because there is no standard file transfer protocol for 
modems as there is for network transfers.)

4. Select Send File in Network menu.

5. Select file to send.

6. Select Transfer Format.

7. Type name for file on the remote computer.

8. Click Send.

Once you click Send the selected file will be copied to the other computer.  Depending on what 
computer you are sending the file to, a message may be displayed in the session window when the 
transfer is complete.

You can cancel a file transfer by selecting Interrupt under the Network menu or its keyboard 
equivalent, ⌘-. (Clover-period).

Send other files from your Macintosh to the remote computer by repeating steps 4 to 8 above.

9. Save session transcript (optional).

10. Log off from the remote computer.

Or select Goodbye from the Commands menu.  The connection to the remote computer will be 
terminated.

11. Click the close box.

The window will be closed and the window that was active when you started the Send File will 
be the active window again.

Receive File - Phone Account

To copy a file from a remote computer to your Macintosh with a phone account, use Terminal 
Session to connect to the computer, prepare for the transfer on the remote computer,  and select 
Receive File to start the transfer process.  
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Many of the steps in the process are the same as for copying a file with a network account; 
common steps are not explained below.  See “Receive File - Network Account” starting on page 
101 for details about those steps.  The main differences for phone accounts is that you have to 
prepare for the transfer process on the remote computer (step 3 below) before selecting Receive 
File, and that files on the remote computer are not listed, as they are for network accounts.  
Do the following after starting TOPS Terminal:

1. Select Terminal Session in the Network menu.

2. Select account and click Connect.

A normal terminal session will be started up; you will next be asked where to save the session 
transcript, unless you checked Don't Save Session Transcript in the description of the account.  
You will be asked for your password if you did not include it in the account description.

3. Prepare for transfer on remote computer.

Prepare for the transfer process by starting the appropriate “upload” process, which varies with 
different operating systems (uploading is the act of copying a file from a local computer to a 
remote computer; when you copy a file from a remote computer to your Macintosh, the remote 
computer regards it is an upload).  

(This upload process must be started because there is no standard file transfer protocol for 
modems as there is for network transfers.)  

4. Select Receive File in Network menu.

A dialog window will be displayed.  You will be asked to type the name of the file on the remote 
computer and the name the file will have on your Macintosh.  Because of the limitations of phone 
connection protocols, files and directories on the remote computer cannot be listed: 

5. Type the name of the file you want to copy.

Remember to include all the information necessary to allow TOPS Terminal to find the file you 
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want to copy.  Depending on what directory you are in when you connect to the other computer, 
you may have to include the full “path name” of the file.  

As you type the name of the file on the remote computer, the same name is being entered as the 
name of the file on your Macintosh.  If you want the file to have the same name on your 
Macintosh as it has on the remote computer, you only have to type one file name.

6. Change the file name on your Macintosh (optional).

If you want the file name on your Macintosh to be different than the name on the remote 
computer, select the Name box on the right side of the dialog window by clicking and holding the 
mouse button as you move the mouse, highlighting the part of the name that you want to change.  
Type the name as you want it.  

Note about copying MacBinary files:  You cannot change the name of a MacBinary file in 
this way; the name of the file is included in the file itself, so changing the name externally does 
not affect the name.  If you want to change the name, copy the file to your Macintosh and then 
change the name .

7. Select Transfer Format.

8. Click Receive.

Once you click Receive the selected file will be copied from the remote computer to your 
Macintosh.

Details about the transfer are displayed in the window.  The main thing you want to check is the 
end of the transcript, where you should see “Transfer complete” (or a similar message).  

9. Save session transcript (optional).

10. Log off from the remote computer.

Or select Goodbye from the Commands menu.  The connection to the remote computer will be 
terminated.

11. Click the close box.

The window will be closed and the window that was active when you started the transfer process 
will be the active window again.

newpath
72 144 moveto 0 9 rlineto 0 -9 rmoveto 9 0 rlineto
72 756 moveto 0 -9 rlineto 0 9 rmoveto 9 0 rlineto
468 144 moveto 0 9 rlineto 0 -9 rmoveto -9 0 rlineto
468  756 moveto 0 -9 rlineto 0 9 rmoveto -9 0 rlineto
stroke


